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Our Support Team wants to make sure you get the help you need!

Knowledge Base https://support.easyworship.com/support/solutions
Technical Support https://support.easyworship.com/support/home
User Forums https://support.easyworship.com/support/discussions
Create a Ticket https://support.easyworship.com/support/tickets/new
Email support@easyworship.com

Online training videos for EasyWorship are available on our website at
support.easyworship.com as well as in the EasyWorship software under the Web tab.
Internet access is required to view these videos.
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Navigation (Menus And Toolbar)

Main Sections of the Interface

EasyWorship makes it easier than ever to build and present a schedule. If you've used
previous versions, you'll recognize the flow: using the Resource Area on the bottom to
build the Schedule Area on the left, the Preview Area in the middle, and then present
from the Live Area on the right. You can still double-click any item in the Schedule or
Resource Area to go live immediately, and additional menu options have been tucked into
menu drop-down buttons located in the corners of each section of the interface.

The user interface consists of the following major sections:

Menus and Toolbar This section contains the menus and toolbar, used for accessing all
available features of EasyWorship.

Schedule Area This section allows you to build a playlist or "set list" of items you want to
present during your worship service (e.g., songs with backgrounds, scriptures, PowerPoint
slides for the sermon, live camera feeds, a mini-movie for offering or a sermon illustration, a
website, and lots of other options).

Preview Area This section displays a preview of the slide before going live, so that it can be
edited.

Live Area This section allows you to see the current live slide that the audience is seeing as
well as any sub-slides that are a part of the active slide group, e.g., multiple slides within a
song, looping presentation, or a long scripture reference.

Resource Area This section contains all of the media that can be used in the schedule.
There are five tabbed resource libraries: Songs, Scriptures, Media, Presentations, and
Themes.
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[E] crorus 1
‘Come to my soul, blessed Jesus.
Hear me, O Savior divine.
Open the fountain and cleanse me.
Give me a heart a heart like Thine.

Give me a love that knows no il
Give me the grace to do Thy will,
Pardon and cleanse this soul of mine.
Give me a heartlike Thine.

Only ajoy, a few brief years,
Only a dream, a vale of tears;
Vain s this world, | now resign.
Give me a heartlike Thine.
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Ml =] chorus 1

Hear me, O Savior divine.

Give me a love that knows

Give me a heartlike Thine.
HE] verse 2

Live Output

Preview Output

A Heart Like Thine
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Title

Author Copyright

A Heart Like Thine Judson Van DeVenter Public Domain

AMighty Fortress s Our God
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| My coLLECTIONs
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ANew Name In Glory
A Robe Of White

Abide With Me

Alas And Did My Savior Bleed

All Creatures Of Our God And King
All Hail The Power Of Jesus Name.
All People That On Earth Do Duell
Alleluia Alleluia

o

Hans Leo Hassler Martin Luther
C. Austin Miles

Public Domain
Public Domain
Haldor Lillenas

Henry . Lyte William H. Mok

Hugh Wilson lsaac Watts.

. Francis of Assisi Willam Henry Draper

Public Domain
Public Domain
Public Domain
Public Domain
Edward Perronet James Ellor John (adapted) Rippon  Public Domain
Ken Thomas Louis Bourgeois William Kethe Public Domain
Chistopher Wordsworth Ludwiq van Beethoven __ Public Dorain
1 of 223 songs

Menus

File Menu

B EasyWorship - Your Church - Default

File

Edit Live Profiles

View Help

MNew

Open Schedule

Save Schedule
Save Schedule As...

Cloze Schedule
Reports and Printing
Reopen

Exit

?
Ctrl+0

Ctrl+35

Web

Print Schedule Report (Summary]...
Print Schedule Report (Details)...

Print Song Activity Report...
Print Song List Report...

Save Schedule Report (Summary]...
Save Schedule Report (Details)...

Save Song Activity Report...
Save Song List Report...
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Gives you the option to create a new schedule, song,

e presentation, or song from SongSelect.

Open Schedule Opens a saved schedule.

Save Schedule Saves the active schedule.

Save Schedule As... Saves the active schedule with another specified file name.
Close Schedule Closes the active schedule.

Reports and Printing >

Reopen >

Exit

Edit Menu

B EasyWorship -

File = Edit Live

Paste
Delete
Select All

Options...

Cut

Copy

Paste

Delete

Select All

Options...

Live Menu

Provides options for printing song and schedule reports.
For more information, see Songs: Printing and Reporting.

Displays a submenu with all recently-saved schedules.

Exits the EasyWorship software.

Your Church - Defauli

Profiles  View He

Ctrl+X r

Ctrl+C
Ctrl+V
Ctrl+Del
Ctrl+ &

Removes the selection and places it on the clipboard.
Copies the selection to the clipboard without removing it from the project.

Pastes the clipboard contents, either inserting it at the cursor point, or
replacing the current selection.

Similar to Cut, but removes the selection without copying it to the clip-
board.

Selects all items in the schedule.

Opens the Options window.
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> EasyWorship - Your Church - General
File Edit | Live @ Profiles WView Help

Go Live

Lege on Live Output
Black on Live Qutput
v Clear Text on Live Qutput

Show Live Qutput

Go Live

Go Back

Logo on Live Output

Black on Live Output

Clear Text on Live Out-
put

Show Live Output

Profiles Menu

DG et e

Allows you to send the current item in the preview screen
to the live output.

Allows you to jump in and out of a PowerPoint present-
ation without losing your place.

This is a toggle that sends the selected Logo image to the
live output. Click the menu item again to toggle the logo
off.

This is a toggle that sends a solid black screen to the live
output. Click the menu item again to toggle the black
screen off.

This is a toggle that clears all text and foreground ele-
ments from the live output. Click the menu item again to
toggle the text and foreground elements back on.

This is a toggle button that allows you to enable or disable
the video output from EasyWorship to the video screen.
When the Live text is blinking, the output from EasyWor-
ship is "live" on the audience screen. When it is not blink-
ing, the audience will see the Windows wallpaper or
another program on the audience screen.
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» EasyWorship - Your Church - General

Eile Edit Live @ Profiles

View Help

Default

* (General
MensGroup
WornensGroup
Youth

Profiles Manager...
Add/Remove Demo D

Litilities

ata...

E Rezet Songs to Default Theme

<Profile Name>

Profiles Man-
ager...

Reset Songs to
Default Theme

Add/Remove Dem-
o Data

Utilities

Rebuild Search Keys

This portion of the menu lists all available profiles.

Opens the Profiles Manager window.

Allows you to add or remove the demo data from the currently-
selected profile.

Reset Songs to Default Theme - This will roll back any cus-
tomization made to the songs in the selected profile. After select-
ing this option, you will receive the following confirmation window.

."-I Are you sure you want to reset all of the songs in the active profile to
use the default song theme?

8

Yes Mo

Rebuild Search Keys - If you are attempting a keyword search
within a Russian or Ukrainian song, the search function may not
initially be available. If so, run this utility to manually rebuild the
database. If this does not resolve the issue, contact Easy Worship

support.
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» EasyWorship - Your Church - General

v Preview and Live
Preview and Live Combined

Live with Resource Preview

Eile Edit Live Profiles ‘-quw Help
Ly’

schedule

Preview and Live

Preview and Live Com-
bined

Live with Resource Pre-
view

Help Menu

This view divides the top section into 3 separate parts -
Schedule, Preview, and Live. There is no Compose
section in this view. Instead, select the desired song in
the Songs tab, then select the Themes tab. Drag the
desired theme into the Preview Output to change the
theme of the entire song, or onto a single slide to change
the theme of that slide only.

This view allows you to preview and go live in the same
window. When you select a resource, it will show up in
the Live Area, but does not go live until you click

Go Live. To compose in this view, select the desired
song in the Songs tab, then select the Themes tab.
Select a theme to use with the selected song. Drag the
theme to the slides in the Live Area.

This view shows a preview in the Compose section of
the Resource Area, as well as in the Schedule. The live
outputis shown in the Live Area. You can now compose
quickly using this view. Select the desired song in the
Songs tab, then select the Themes tab. Select atheme
to use with the selected song. To go live, click Playabove
the Compose section. Or, to add it to the Schedule, click
Add.

9




> EasyWorship - Your Church - Default
File Edit Liwve Profiles View Help\s

EasyWorship Help
Video Codec Troubleshooting

PowerPoint Troubleshooting
Check for Updates...
Background Helper

Register Products...
About EasyWorship...

EasyWorship Help

Video Codec
Troubleshooting

PowerPoint
Troubleshooting

Check for Updates...
ware.

Background Helper
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Opens the EasyWorship help file.

Displays a list of the most recent codecs used for displaying
video in EasyWorship.

Provides information about the interactions between
EasyWorship and PowerPoint.

Checks for any available updates to the EasyWorship soft-

The Background Helper displays background processes,
such as importing PowerPoint slideshows or indexing media.

Opens the About EasyWorship window, with the Register
tab selected. This window allows you to deactivate the
current copy of EasyWorship, add or change product keys,
and add or change license files.

10

About EasyWorship
About
License

Copyright

Register Products...

Register

EasyWorship 6 Site License

multi-projector / single campus (ne subscription)

You are connected to the following Organization

Your Church
support@easyworship.com

Disconnect and deactivate this copy of EasyWorship

Add bibles or change registration using a Product Key

Add bibles or change registration using a license file

Close

-10-
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Opens the About EasyWorship window, displaying the cur-

About EasyWorship... ot version of EasyWorship.

Toolbar
[ EasyWorship - Your Church - Default — O X
File Edit Live Profiles WYiew Help
L7 | g 7 s |
0. ¥, & E o4 = @ = 2 = L4
New Open Store  Web Go Live Alerts Logo Black Clear Live

Displays a drop-down menu that allows you to create a new Schedule,
Song, Presentation, or import a new song from SongSelect.

B EasyWorship - Your Church - Default
Eile Edit Live Profiles View Help

New o . bW ¥ &

Mew Open Store  Web

Mew Schedule He
Mew Song...

Mew Presentation...

Mew Song from SongSelect...

Displays a drop-down menu with the option to browse for a saved schedule,

e or choose from the most recently-saved schedules.

Save Saves the active schedule.

Store Opens the EasyWorship media store.

Web Displays a web browser in place of the Preview Area and Live Area.

Go Live Allows you to send the current item in the preview screen to the live screen.

Click Alerts to add an alert to your live output. You can set the appearance
Alerts of the alert in the Alerts options, located in Edit > Options... > Alerts. For
more information on the available settings, see Alert Options.

This is a toggle that sends the selected Logo image to the live output. Click

Logo the button again to toggle the logo off.

Black This is a toggle button that sends a solid black screen to the live output. Click

-11 -
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the button again to toggle the black screen off.

This is a toggle button that clears all text and foreground elements from the
Clear live output. Click the button again to toggle the text and foreground elements
back on.

This is a toggle button that allows you to enable or disable the video output
from EasyWorship to the video screen. When the Live text is blinking, the out-

Live put from EasyWorship is "live" on the audience screen. When it is not blink-
ing, the audience will see the Windows wallpaper or another program on the
audience screen.

Search

B EasyWorship - Your Charch - Default - o ®

File Edt Live Profiles View Help

o (d- bW & = @ = e LA
New Open  Smve  Web Golive  Alerts logo  Black  Clear Live
Schedule - UNTITLED U3 = | @+ Preview - & Heart Like Thine 5 v | Live - Genesis 1:12 (KIV) i

AHeart Like Thine Bloee &l
- e Come to my soul, blessed Jesus. brought forth grass, [and] herb yielding seed séter his
Heat me, O Sivior divine. Kind, and the tree yieldng fruit, whese seed [was)] in itse, after his

Cpen the fountain and cleanse me. Kind: and God saw that [t was] good. |
@ Chorus 1 Grve me & heart a heart fike Thine.
Come to my soul, blessed Jesus
— - veeset
Give me a love that knows no ill.
. A e |
Give me a love that knows no ll. Pardon and cleanse this soul of mane.
— .
Give me a heart ke Thine.
! Omly a joy, o few brief years, Cinly 8 Joy, a few bres years,
Preview Output Live Outpu
= Open mine eyes that | may see
—

2 And the earth brought forth grass,
[and] herb yielding seed after his

kind, and the tree ing fruit,
whose seed [was] in after his
kind: and God saw that

- - Shice 1041
So Scriptures | ia |
ngs criptures | Media P

A ¥ Search An File Marne
MEDIA

= Videos

=] Leaves Lgmrnu Lirme Li gF Lowe of a Fat. rmngC!.’ Mesmin gl;}-

‘ﬂf}‘?l!ma |

The Search function is located above the Resource Library. Previously limited to songs,
you can now search within all libraries in the Resource Area with two different search
modes. Search by resource title, by scripture reference, or by keyword. Toggle between
search modes by clicking the icon on the left side of the search box = Genesis1.

For more information about the Search function, see Scripture Search and Song Search.

-12-
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Schedule Area

The Schedule Area in EasyWorship allows you to build a playlist or "set list" of items you
want to present during your worship service (e.g., songs with backgrounds, scriptures,
PowerPoint slides for the sermon, live camera feeds, a mini-movie for offering or a sermon
illustration, a website, and lots of other options). This article will introduce you to the basics of
how to build your first Schedule, how to edit and re-order the items within the Schedule, and
how to save it as a file so that it can be shared with other users.

Adding Items to the Schedule

Add Items

Adding items to your Schedule is as easy as dragging and dropping a song, scripture,

media item, or presentation from the Resource Area below to the Schedule Area. Try
adding a few items to your Schedule.

B EasyWorship - Your Church - Defautt - X
File Edit Live Profiles View Help

e (@ o B E | B =5 E = -
New  Open Web Gol ive
Schedule

&5~ | # | Preview - 95 APsalm Of Praise. S

Songs  Scriptures | Media | Presentations  Themes
Qv

MEDIA

I Videos

[ Images

X Feeds

© pvo

[€] Audio
COLLECTIONS
MY COLLECTIONS

1. To start your next service with a mini-movie opener, go the Resource Area and click
the Media tab.

2. Select Videos from the list on the left.

3. Clickthe + (add) button in the Resource List Area on the right, search for your mini-
movie file, then click Open to add the file to your Resource Library.

-13-
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4. Now, just drag-and-drop the video file from the Resource Area to your new Sched-
ule.

Adding more items to your Schedule is just as easy. To learn more, see Add a Song or Add
a Scripture.

Drag-and-drop Features
You can drag-and-drop Schedule items around to re-order your set list.

In the Preview and Live and Preview and Live Combined views, you can drag media
items on top of each other in the schedule and EasyWorship will create a presentation.
Drag them to the Preview Area and they'll be added to the presentation.

Customize Your View

Customize the icons in the Schedule Area as small, medium, large or summary view. Just
click the drop-down arrow at the top of the Schedule Area and use the slider to customize
the icon view.

File Edit Live Profiles Help

ol o @
Open Save Mew Web
Schedule - 141207 _Wership_2n..,

- We Will Glorify

i Alas And Did My Savie|
[ i

-“Genesisl:l[H(SB]I — 29 Smalllcons

== Summary View

[ 4

= Largeleons

Medium Icons

B 5770

Verse 3

@ hpm_are_you smarter_no...
TRE T CoMET™
—

e —

Assign a Background or Audio to Songs

It's easy to add a background, camera feed, or audio track to your song slides.

-14-



EasyWorship 6 User Guide 15
Getting Started

1. Click the Media tab in the Resource Area.
2. Select Videos, Images, Feeds, or Audio from the left.

3. Draganitem from the Resource List Area on the right and drop it on top of a song
in the Schedule Area. That item has now been assigned to the song in the Sched-
ule. The song's master thumbnail in the Resource Area will reflect your changes.
(You can assign audio to a slide or song even if you have already have a background
assigned toit.).

You can also assign a background or audio to an individual slide within a group of slides.

1. Click the arrow next to the song slide in the Schedule Area.The slides will expand so
that you can see each individual slide for the song.

2. Drag-and-drop a media item onto an individual slide.

Dragging a media item onto the master slide of a song will apply the background to all
slides, even slides that already have a background assigned to them. (For more about
customizing slides, see Customize Song Slides).

NOTE You canright-click any theme in the Themes Area and click Set as Default. You can
set a default for songs, scriptures, and presentations.

Creating Announcement Loops

Announcement loops can be created in either EasyWorship or PowerPoint and loaded into
the Presentations tab. The announcement loop will be added to the Schedule from the
Presentations tab where all EasyWorship p[resentations and PowerPoint slideshows are
stored.

For more information on how to create announcement loops, see Announcement Loops.

Editing Schedule Items

When editing the Schedule, you have the following options.

-15-
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Schedule - burdens.ewsx S v | %~ | Preview - My Burdens Rolled Away

e o P P
Import Schedule File...

Add ltem »
e Edit Item...

Exodus 2:11 (KJV) L
i‘ I Edit Title...
Edit Mote...

Move Item Up

MNew Blank Presentation...

Browse For Presentation File...

Browse For PowerPaint File...

Browse For Media File...

Mowve ltem Down Verse 4

| am singing

Remove from Schedule

Expand All tems
LCollapse All ltems

Check Schedule for changes...

Auto-Expand lterms When Dragging
Refresh Thumbnails

e = _._M __..
, Rolledawayﬂ'rplledawav_,

View S 1am happysince my burdens
rolledfaway.
Rolled away, rolled away, n
Allows you to import an existing
Import Schedule File... schedule into the active sched-
ule.
New Blank Adds a blank presentation to
Presentation... the end of the active schedule.

Allows you to add an existing
EasyWorship presentation to
the active schedule.

Browse for Presentation
Add Item File...

Allows you to add an existing
PowerPoint presentation to the
active schedule.

Browse for PowerPoint
File...

Allows you to add any com-
Browse for Media File... patible media to the active

schedule.
Edit Item... Opens the "Schedule Editor" on page 19.
. Allows you to add a note about a particular Schedule item.
Edit Note... : o . .
This option is grayed out when in Summary View.
Move Item Up Moves the selected schedule item up.
Move Item Down Moves the selected schedule item down.
Expand All Iltems Expands all schedule items.
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Collapse All Items

Check Schedule for
changes...

Auto-Expand Items
When Dragging

Refresh Thumbnails

View
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Collapses all schedule items.

Allows you to bring any changes you made to a song or
presentation in the schedule into the database. It also allows
you to import media items from the schedule that are not in
your list of media items. See "Check Schedule for Changes"
below for more information.

When moving media around in the schedule, select this
option to expand any media item when hovering over it while
dragging another media item.

Refreshes the thumbnail images displayed in the Schedule
area.

Allows you to display the schedule in small icons, medium
icons, large icons, or as a summary.

Check Schedule for Changes

After making changes to a presentation or song within the schedule, EasyWorship allows
you to save those changes to the media item in the database. Additionally, if you are using
an item in your schedule that doesn't currently exist in the database, you can also import

those items for future use.

1. Right-click in the Schedule area and select Check Schedule for changes.... The
Import schedule items window appears.

-17 -
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B Update Local Computer

Import schedule items

Individually select which iterns or properties to update,

7 ‘ | All Hail The Power Of Jesus Name

replace -

Select / deselect all e
[ Import only lyrics for songs
[] Show this windew when a schedule is open Import Cancel

2. Select the desired item and use the button on the right to either replace or add.

3. You can also click Compare to display a comparison between the version in the

database and the version from the schedule. The Compare Schedule to

Resource window will appear.

4. Click Import to import the changes or Skip to skip this schedule item and move to

the next one.

18
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And crown Him crown Him,
Crown Him crown Him,
And crown Him Lord of ALL.
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All hail the pow'r of Jesus' name,
Let angels prostrate fall,

Let angels prostrate fall,

Bring forth the royal diademn.

Verse 2
Ye chosen seed of |srael's race,
Y¥e ransomed from the fall,
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Schedule Resource B=: v
1 &L :

And crown Him crown Him,
Crown Him crown Him,
And crown Him Lord of all.

> =

All hail the pow'r of Jesus' name,
Let angels prostrate fall,

Let angels prostrate fall,

Bring forth the royal diademn.

Verse 2
Ye chosen seed of |srael's race,
Y¥e ransomed from the fall,

e ransomed from the fall,
| I [ ey

3E

snalm o s s s amnn b

Resource Preview

And crown Him crown Him,
Crown Him crown Him,
And crown Him Lord of all.

ot ey Ebar Jobes (stapted) Biaon

Slide 1 of 5 >

Import Cancel

Schedule Editor
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B Schedule Editor - Daniel 10:21 (KJV) o x

[ Tzhoma ~ | [Auto ¥ ar a- [

Words | Slides Masters

1 Daniel 10:21 (K/V)
ew the

21 But lwill sh, e that which is noted in the scripture of
that holdeth with me in these things,

21 But I will shew thee that which is

noted in the scripture of truth: and
there is none that holdeth with me in

these things, but Michael your prince.
Daniel 10:21 (KJV)

+ v Insert 5% [} e
Toolbar
|Exctluz 211 (KIV) ‘ U' T Ij L Bl =R
(1 0 = A{fv > T;m‘eme Text Scripture Iv?edia Arrange
|Tahoma ~||Auto V‘ VYA |I|I lel = EE' ?Elé
. Enter a name for the song, scripture, theme, or present-
Title e o
ation in this field.
Theme Use the drop-down to select a theme. (This option is
grayed out in the Theme Editor.)
Text Adds a text box to display on each slide.
Scripture Click the scripture button to select scripture text and
P press enter or drag it to add it to the theme.
Click the media button to select videos, images, feeds,
Media DVD clips, or audio and press enter or drag it to add it to

the theme.

Clicking this button allows you to set the layer at which
Arrange the selected element resides. You have the option of
Move Up, Move Down, Bring to Front, Send to Back.

Opens the Inspector window. This allows you to make

Inspector more detailed formatting changes to different elements.

Import Allows you to import a text document into your song,

-20-
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presentation, or theme.

Allows you to print the song, schedule, theme, or present-
ation.

Checks spelling and allows you to make spelling
changes or add words to the dictionary. To add a
language to the spell check dictionary, click the Spell
Check button and select Spelling Options....

| R i |
L&~ - Theme Text
Tahoma Check Spelling vl av oA |[

Words  Slide 5pelling Opticns...

1. The Spelling Options window will
appear. Select the Language tab.
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22

Spelling Options
Speling Landuage  Custom Dictionany

Language settings

Choose the |language dictionany to uge when checking =

Englizh e

Additional dichionanes

Choose ary additional dictionaries to use when checking

autocarrect. adu cuztam dictionary
] custom.dic Microzoft Office custon

Locate Dichionanes. ..

Learn About bMa

Dronl

[

Click Download Additional Dic-
tionaries. The Additional Dic-
tionaries page will load.

Download the dictionary you wish to
add to EasyWorship.

Browse to the file you downloaded
and extract it.

In the Spelling Options window,
click Locate Dictionaries....

Browse to the folder you extracted,
select it, and click OK. The new
dictionary will now be available in the
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Font Selector

Auto Sizing

Font Size

Font Color

Text Style Options

Horizontal Alignment
Options

Vertical Alignment
Options

Indent / Outdent

Reset Styles

Apply changes to items

in schedule

Tabs
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drop-down list under Language
settings.

Click the font selector to select the font formatting you
wish to use on selected text.

Allows you to choose between setting an exact font size
or automatically sizing the font.

Changes the font size of the text to the point size selec-
ted.

Allows you to change the color of selected text by select-
ing from the color palette provided.

Bold, Italics, Underline, Shadow, Outline

Left Align, Center Align, Right Align

Top Align, Middle Align, Bottom Align

Increase or decrease the indent level of the paragraph.

Resets formatting to default settings.

& v Insert

Apply changes to items in schedule

23

Check this box to apply all of the edits made in the Editor
to that item in the currently-open schedule.

1. The Words tab or Slides tab can be used to enter or edit text as needed. The
Words tab will display only the text on the left with the Slide Editor on the right.

2. Use the toolbar to change the font and edit its style, size, and alignment.

3. Use the heading buttons to select a Theme, create a new Text box, add a Scripture

or Media element or Background, or Arrange Elements.

4. Use the Inspector to customize your presentation.

5. The Slides tab displays a thumbnail of the slide on the left, with the Slide Editor on
the right. In this view, you can change the text and slide background. You can also
select multiple slides to edit, duplicate, or delete.

6. To use the same background for all slides, select the Master tab and select the mas-
ter slide, which will be the first slide. Use the "Background" on page 86 tab in the
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Inspector to change the background. To use a different background, click Media and
drag-and-drop the image or video to the desired slide. When you're finished, click
Master Theme.

7. Tochange the background, click the Slides tab. To use the same background for all
slides, click Master Theme at the bottom of the Slides tab and select the master
slide, which will be the first slide. Use the "Background" on page 86 tab in the
Inspector to change the background. To use a different background, click Media and
drag-and-drop the image or video to the desired slide. When you're finished, click
Master Theme.

Saving & Transferring a Schedule

You'll want to save your Schedule at some point. Maybe you need to email your Schedule
file to someone, or save it to a memory stick or cloud service. No matter what you need to do
with your new Schedule file, follow these steps to get started.

1. Click Save |_] in the main toolbar OR click File > Save Schedule.
Save

2. Name your Schedule file and click Save. To run the Schedule from the same com-
puter, you can uncheck the option to Pack files in schedule box. This will save
space on your computer. If you'll be transferring the schedule to another computer,
make sure that box is checked. Everything you add to the Schedule will be packed
into the Schedule when you save it...all in one file. Simple! It's an easy way to take
one file to another computer and open it to start your worship service.

NOTE EasyWorship will save your new Schedule file to a default location. If you would like
to save to another location (e.g., memory stick), be sure to navigate to that location before
clicking Save.

Open & Use an Existing Schedule

If you want to use a Schedule file you've received from someone else, it's easy to get
content from the Schedule to the screen.

1. Click Open —_ onthe toolbar or select File > Open Schedule.

Open

2. Navigate to the desired file and click Open.

3. When the Schedule opens in EasyWorship, select an item in the Schedule Area and
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click Go Live = . EasyWorship automatically selects the nextitem in the Schedule

so all you need to do is click Go Live again to send the next item to the screen. If you
don't see the item on the live screen, make sure you've clicked Live 'i‘ on the far

right of the main menu.

Presenting a Schedule

1. Select the firstitem in the Schedule and click Go Live 5% on the toolbar. If you don't

see the item on the live screen, make sure you've clicked Live .4 on the far right of

the main menu.

2. When you are ready to send the next item to the screen click Go Live again.

Using Logo, Black, Clear

¥ EasyWorship - Default
File Edit Live Profiles Help

- E B A

Open New  Web
Schedule - 141207 Worship_2n... 55 v | ¥ | Live - We Will Glorify

"m\mu Glorify

j’.ﬂhs And Did My Savior Bl...

—

- Genesis 1:1 (HCSB)

6770

hpm _are you smarter_no..

TRE T CONEE™
e,

-‘ -

Songs  Scriptures | Media | Presentations Themes

Logo Black Clear Live

We wi. 3
We will glorifyitne;uuraof lords
Who is the great I Am

Slide 1 of 4 >

File Name

>

MEDIA Title
[ Videos {ERE IT COMES™
[ Images =T —
&M Feeds fp_snow fallin... hpm_are_you_..
@ pvb

144} Audio
COLLECTIONS = ‘ ‘ 1
MY COLLECTIONS =

mop_inside_to..  pgm_blue and..

| B - 24

hpm_christma...  im_ib05_colors...  img_kaleidoor...

m

pgm_greenra..  sw_autumnsu..  sw_blue rush.S...

1 of 14 items 2w

Logo Button

At the beginning or end of a presentation, you might want to display a logo or title screen.
Logo allows you to quickly display an image, video, or presentation that has been assigned
as the logo background. Here's how to assign an image as the logo:
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1. Inthe Resource Area, click the Media tab, select Images, Video, or Presentation
from the Resource Library on the left.

2. Right-click the image in the Resource List Area to the right.
3. Select Set As Logo Background.

Black Button

Mistakes happen. When you need a quick save, Black is a quick and easy way to transition
the entire screen to black.

Clear Button

Clear removes text from the screen while leaving the background running.
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Preview Area

Side2of 5

The Preview Area displays a preview of the current selection, whether it's a media item in
the Resource Area, or an item in the Schedule. You can double-click the item in the
Preview Area to send it to the live output immediately. You can also advance through
multiple slides in the Preview Area using the forward and back buttons, but this does not
advance them in the live output.
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Live Area

The Live Area displays the current live output. You can advance through the slides using the
forward and back arrows. No editing can be done in the Live Area. However, if you are
currently on a Logo, Black, or Clear screen, you can double-click a slide in the Live Area to
turn that off and resume Live Output.

-28-



EasyWorship 6 User Guide 29
Getting Started

Resource Area

Library Tabs -
{ Resource Listing
I Songs  Scriptures | Media | Presentations  Themes I + >
Search ——
p—
MEDIA )
: -
=] Images L
Resource EH Feeds P
— P
Library L
|%2] Audio
COLLECTIONS 95 A Psalm Of Praise Air Ball Autumn Dreams
MY COLLECTIONS
=3
_ u v
Sow | v 1 of 68 items EE -

A collapsible Resource Area spans the bottom of the application. At the top are five tabbed
libraries: Songs, Scriptures, Media, Presentations, and Themes. In the default view
(Preview and Live), the Resource Area has two columns:

1. Resource Library tabs on the left.

2. Resource Listing and details in the middle.

Additional menu options are now in drop-down buttons in the bottom left of the Resource
Library and Resource Listing, including Add Item and Action Menu buttons +~| =~ .In

the Resource Listing, there's an icon view drop-down with a slider that allows you to
customize your view for thumbnails or list view | = -|.

Presentations - Presentations in the Resource Area will house any EasyWorship
presentations you build in EasyWorship and PowerPoint slideshows. You'll now have a
complete searchable library of presentations at your fingertips. No need to search your hard
drive for a PowerPoint file when it’s right there in EasyWorship.

Themes - The Themes Area allows you to make templates that you can apply to scripture,
songs, and presentations. The responsibility of what used to be called backgrounds is now
handled between media and themes. Both will be available in the song editor for convenient
access. You'll no longer have to load media items in two separate libraries to have
backgrounds available in the song editor.

Collections - The Resource Area now gives you the power to create Collections based on
criteria you define, i.e., you can create a Collection of songs that are written by the same
author, or create a Collection of videos or images that have cross in the name.
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Purchasing & Installing Bibles

Adding Free Bibles

EasyWorship has many free bibles available. There are also many copyrighted bibles
available for purchase as add-ons.

[ j"NasAnd Did My Savior Bl
) tes

Versel

Versed

Slide 1 of 4

Songs | Scriptures | Media  Presentations Themes

SCRIPTURES Visible Translation Abbrevistion  Language Available
Wil HCs8 Jodo Ferreira de Almeida Atualizada  AA PT Free
kv ¥ King James Version v EN Installed
il NV B
La Biblia de las Américas LBLA £
(¥
O ava Latin Vulgate vuL LA Free £
I More Available... Louis Segond LSG FR [I]
i COLLECTIONS Luther Bibel 1545 LUTH1545 DE
b MY COLLECTIONS Maori Bible MAGRI M
Modern Greek GKM EL [ Free |
v v v 1 of 44 references =

1. Open EasyWorship.
2. Clickthe Scriptures tab in the Resource Area.

3. Atthe bottom of the Scriptures list on the left (list of currently installed bible versions),
click More Available....

4. Inthe list of available Scripture versions on the right you can see a full list of free and
purchasable bible versions. If the bible you want to install is free, click Free to install it.

5. Ifabible you want to add is not free, click Buy on the right. In the new window, log in
to your EasyWorship account.

6. Once you are logged in, make sure you're connected to the correct Organization and
click Buy.

7. A window will open to complete your purchase. Enter your payment information and
click Place Order. When the order is complete, EasyWorship will automatically down-
load and install the bible.

8. If you purchased a bible on easyworship.com or worshipmedia.com, the bible will
show as installed when you’re logged into EasyWorship with your account.
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Purchasing Bibles

1. Go to www.easyworship.com and sign in to your account.

2. Click Software at the top of the page, then Bible Plug-ins.

easSYWCRSHIP

M SOFTWARE MEDILA STORE TRAINING SUPPORT
EasyWorshi w ewTek Integration System Reguirements

3. Click Add next to the bible you wish to purchase.

MSG - The Message English $29.00
2002 MavPress Represented by

Tyndale House Publishers, Inc.
NRSV - The New Revised English $29.00
Standard ’
~ 1989 National Council of the /
Churches of Christ
RSV - The Revised English
Standard Version el

1971 National Council of the
Churches of Christ

4. After you have added the desired bible(s) to your cart, you can see them when you
select My Cart.

5. Click CHECKOUT and enter your payment information to complete the purchase.

Download the License File and Bible Text files

You can access the license file by selecting Your Account > Software Licenses.
Click Download License File.

Once you've downloaded the license file, copy it to a flash drive (USB memory stick).
Click Get Bibles Here.

Find the bible(s) you just purchased and click Download.

o M N =
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6. Copy the bible files to your flash drive (USB memory stick).

NOTE If you are downloading a bible version that comes with other versions like the NASB
and NIV bibles, they will be in a zip format. You'll need to unzip the files by right-clicking on the
file and clicking Extract... before importing them into EasyWorship.

Importing the Bible Plug-In into EasyWorship

1. Insert the flash drive into the computer to which you wish to install the bibles.

2. Open EasyWorship and select the Scriptures tab.

3. Click More Available... at the bottom of the list of bibles.

4. Clickthe gearicon g~ atthe bottom of the list of available bibles in the middle

column.

Click Install From Disk...

Browse for and select the bible file(s) you wish to install.
Click Open.

Click Help > Register Products....

© ® N o O

Click Add bibles or change registration using a license file.

10. Browse to the flash drive and select the EasyWorshipLicense.ewl file.
11. Click Open and login.

12. The bible should now be available in EasyWorship.

NOTE You may find it easier to take the computer to a location that has internet access or
use your phone as a Wifi hotspot long enough to install the bible via the internet.
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Helpful EasyWorship Shortcut Keys

EasyWorship can be controlled by using keyboard commands called shortcut keys. The list
of shortcut keys below are divided into two categories; Editor keys for use in the song,
scripture or presentation editor and Show Control keys for controlling a presentation.

Editor Keys
Enter Allows you to put extra spacing between lines of text.
CtrlI+A Selects all text in the text editor.
Ctrl+C Copies the selected text to the Windows clipboard.
Opens the Alerts window, selects the Foldback tab, and opens the
Ctri+F New simple message alert (Foldback) window.
Opens the Alerts window and opens the New simple message alert
Ctri+M (Live) window.
CtrI+N Opens the Alerts window.
Ctri+O Allows you to open an existing schedule.
Ctrl+S Allows you to save the active schedule.
Ctrl+V Pastes the text from the Windows clipboard to the text editor.
CtrI+X Cuts the selected text to the Windows clipboard.
Ctri+Del Deletes the selected item from the schedule.
CtrlI+Enter Creates a new slide or breaks a slide into two slides.
CtrI+End Moves the cursor to the end of the text when in words view.
Ctrl+Shift+End Selects all text from the cursor location to the end of the text in the words
view.
Tab Moves the current line your cursor is on to the right one tab spacing.
Moves the current line your cursor is on to the left one tab spacing. If
Shift+Tab there is no tab spacing at the beginning of a line, Shift + Tab creates a

new slide and moves the line your cursor is on into the Label or Title
field.

Show Controls

Page Down
Ctri+ C
Ctri+B
Ctrl+L

Ctrl + Space Bar
Right Arrow

Go Live command

Toggles text on the live output on and off
Toggles Black Screen on and off
Toggles the Logo on and off

Switches between live output and control screen in single monitor
mode

Selects the Next Schedule Item
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Left Arrow
Home

End

Down Arrow
Up Arrow

V + Enter

C + Enter

# + Enter
V + # + Enter

C + #+ Enter
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Selects the Previous Schedule ltem

Selects the First Slide

Selects the Last Slide

Selects the Next Slide.

Selects the Previous Slide

Selects the first Verse of the song

Selects the first Chorus in the song

Selects the slide number you entered (e.g., Pressing 3 then the enter
key will select slide three)

Selects the verse number you entered (e.g., Pressing V then 6 then
the enter key will select verse 6.)

Selects the chorus number you entered (e.g., Pressing C then 2 then
the enter key will select chorus 2.)
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Dual Monitor Setup

EasyWorship is designed for dual monitor display. That means it can produce two different
displays at the same time. The first display--Monitor #1 or the primary monitor--goes to the
control screen, which is what the operator sees. The second display--Monitor #2 or the
secondary monitor--goes to the output screen that is projected to the congregation (this
could be a TV, projector, or LCD screen). This kind of "Dual Monitor Display" makes it
possible for an operator to be editing the Schedule Area in EasyWorship while the
congregation is viewing only the current song, scripture, video, presentation, or feed.

EasyWorship uses Windows Extended Desktop to accomplish this. The following are three
different video card configurations that will allow you to use Windows Extended desktop:

Video Card Configurations for Windows Extended Desktop

1. A single video card with two outputs. Works with desktop PCs only.
(Recommended)

2. Alaptop with a video output (VGA, DVI, or HDMI) on the side or back of the laptop.

3. Two video cards with a single output on each card. Works with desktop PCs only.
(Not recommended)

Common ways to set up a computer for dual monitor output

1. EasyWorship may be set up with a single monitor on the desk to control the software
(Monitor #1) and with a projector as the secondary output (Monitor #2).

2. Customers using laptops will use their laptop monitor as the control monitor (Monitor
#1) and the output on the side or back of the laptop for output to the audience (Mon-
itor #2).

3. You may also add a video splitter to the secondary output. This would allow you to
have two secondary outputs (live screens) or a second monitor on the desk as well as
a secondary output for the audience.

NOTE See Enabling Windows Extended Desktop for instructions on how to check a
computer for Dual Monitor compatibility and for instructions on setting up Dual Monitors to use
with EasyWorship.
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Enable Windows Extended Desktop

1

2
3.
4

Open EasyWorship.
Click the Edit menu.
Click Options....

The Options window appears.

[ Options O

EvE Live Options

Song Select Output Monitor

Scripture Output Position

-

Top

Foldback width m
Song | -
Scripture Height m

Presentation Output Monitor | Monitor 1 (Secondary)

Alerts Alpha Channel Dizabled w

Alerts and Clocks

" Monitor Setup
Transitions
Screen Margins
Service Intervals
Left Top
Advanced Right Bottom
Default Font
Default Font Default Font
soreg text line one
song text line twoe
song text line thnee
=ong test line four
[ Preview Qutput QK Cancel

5. Selectthe Live tab at the upper left.

6.

7.

In the section titled Live Options, click Monitor Setup.

EasyWorship will open the Screen Resolution window.
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[ Screen Resolution — |

A [ <« Display »* Screen Resolution v 0 Search Control Panel

Change the appearance of your displays

Detect

Identify

Display: 2. G246HL w
Resolution: 1920 = 1080 (Recommended]  ~
Orientation: Landscape ~

Multiple displays: | Extend these displays

This is currently your main display.

[] Allow the screen to auto-rotate Advanced settings

Project to a second screen (or press the Windows logo key S + P
Make text and other items larger or smaller

What display settings should | choose?

oK Cancel Apply

*

o

10.

11.

Select the secondary display. If display 1 and 2 boxes do not appear, your computer
does not have dual monitor capability, or you do not have a projector or monitor
plugged into the secondary video output on the computer.

Under Multiple displays, select the option to extend the display from the drop-down
list.

Set the Screen resolution.
« Standard 4:3 - 800x600 or 1024x768
« Widescreen 16:9 - 852x480, 1280x720 or 1920x1080
o Widescreen 16:10 - 1280x768, 1280x800 or 1440x900

Verify the color setting for monitor 2 is set to 32 bit.
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13. Now you need to set up EasyWorship to use your second monitor. To do this, follow

Setting Up EasyWorship To Use Your Second Monitor

the instructions below.

EasyWorship will normally find the secondary display and automatically send the output to
that screen. However, you may need to set up the output screen manually. The instructions
below will walk you through the process.

1.

Open EasyWorship.

2. Click Edit > Options... to open the Options window.

¥ Opticns

Live
Song
Scripture
Presentation
Alerts

Foldback

Song
Scripture

Alerts and Clocks

Transitions

Service Intervals

Advanced

song text line one
song text line two

song text line

three

song text line four

[ Preview Output

Live Options

Select Qutput Monitor

Output Monitor

Alpha Channel

Screen Margins

Left

Right
Default Font

Default Font

Monitor 1 (Secondary)

Menitor 1 (Secendary)

Bottom

Top

Default Font

Cutput Position

Left
Top
Widlth
Height

Menitor Setup

0K Cancel

3. Select the Livetab.
4.

In the section titled Live Options, select the secondary monitor from the Output
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Monitordrop-down list.
Click OK.

Intel Graphics Monitor Setup

EasyWorship 6 User Guide 39
Getting Started

1.
2.

Right-click the Windows Desktop and select Graphics Properties.

Under Devices or Display Devices, click the Extended Desktop option.

« ThePrimary Device should be setto Notebook or Built-in-Display.

« The Secondary Device should be set to Monitor.

3. Click OK.
4.
5
6

Open EasyWorship.

. Click Edit > Options.

. Inthe section titled Live Options, select the secondary monitor from the Output

Monitordrop-down list and click OK.

Dual Monitor Troubleshooting

If your problem cannot be resolved by following the steps below, contact our Customer
Support Team via email at support@easyworship.com.

ISSUE

| see the same thing on
my second monitor as |
see on my primary mon-
itor.

| enabled the Windows
extended desktop, but it
disables itself after |
apply the setting.

CAUSE

Your windows desktop
has not been extended to
the second monitor.

You have an Intel Graph-
ics card, or you do not
have your projector con-
nected to your secondary
video port, or the projector
is not turned on.

RESOLUTION

Enable the windows exten-
ded desktop. See below:
Enabling Windows Exten-

ded Desktop.

Use the instructions in Intel
Graphics Monitor Setup to
enable the windows exten-
ded desktop for your Intel
Graphics card. Connect
your projector or sec-
ondary monitor to the sec-
ondary monitor port on
your graphics card and
make sure that the mon-
itor, or projector, is turned
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Windows extended
desktop is enabled, but
EasyWorship still dis-
plays the output on my
primary monitor.

The secondary monitor is
not selected as the output
monitor in EasyWorship.
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on.

Click Edit > Options. In
the Live settings, Select
Monitor 2 (Secondary) for
the Output monitor. Click
OK.
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GENERAL TOPICS
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Alerts

EasyWorship allows you to display alerts on both the Live output and the Foldback display
using the Alerts button on the toolbar.

=3 | .

(3o Live Alerts

|l LIVE | FOLDBACK

~ MNursery Alert |:| Add -

—

Message Alert =

Count Message -

= Men's Group - TPM Wednesday in Room 12
3 | Women's Group - 6PM Wednesday in Room 12
k. = CO_END until the service is complete

s CADIAERVILNpne:
7

P Fednblinaramitls

Nursery Alerts

To use nursery alerts, click Alerts in the toolbar, enter the alert message, and click Add.
You can modify the appearance of the alert by clicking Edit > Options... and selecting the
Alerts tab. To delete the alert, click the X next to the alert in the Alerts window.
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=3 | .

Go Live Alerts

LIVE | FOLDBACK

Mursery Alert |:| Add

Parents of child #12, please come to 7 e

Message Alert =

Hide

General Message Alerts

To create a general message alert, click the Message Alert drop-down. You have the
option to Add simple message alert or Create/Edit alert template.... You can modify
the appearance of the alert by clicking Edit > Options... and selecting the Alerts tab.

-43-



=3

EasyWorship 6 User Guide 44
General Topics

'V

o Live Alerts

I+ |l LIVE | FOLDBACK

IA

—

Mursery Alert

Message Alert +

T

[

Countdown
MensGroup

WomensGroup

[i2

Add simple message alert...

Create/Edit alert ternplate...

If you choose to add a simple message alert, the New simple message alert window will
appear. Enter the desired message and click OK. The message willimmediately display to
your live output and be listed in the Message Alert area of the Alerts window.

Mew simple message alert

X

Message text:

oK

Cancel

The scrolling message alert will automatically display 3 times. You can add or subtract the
number of times the message displays by clicking the + or - button. To immediately stop the
alert from displaying, click Hide. If there are multiple message alerts, you can select one
and click Priority to display only that alert. You can click Next to advance to the next alert in

the list.
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w Message Alert =

Count Message |

| 3 Blue Honda Accord, License Plate TFR1126, your lig... €

Hide # || = || A\ Priority P Mext

Alert Template

In addition to creating a simple message alert, you can create an alert template for alerts
you will use over and over again. Click Alerts, then Message Alerts > Create/Edit alert
template... The Live Alert Editor appears.

Live Alert Editor >
Live Alert Editor
Manage existing or create new alerts
Countdown
Alert Mame |MensGroup
WormnensGroup Message

Men's Group - 7PM Wednesday in Room 12

Uze... Edit...
+]=]

Close

To add a new alert template, click + in the left pane. The Edit Alert window will appear.
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Edit Alert e
Alert Mame |m |
Message
Tahoma “[ _J~«|//B| T u|s|o Tokens - | Reset Styles
Display Method | Serolling w Display Count |3 w
oK Cancel
Alert Name Enter a name for the new alert.

Enter the message alert. Use the formatting options to customize
Message the appearance. From left to right, the options are Font, Text Color,
Bold, Italic, Underline, Shadow, and Outline.

Click the drop-down to add or insert a token. For more information,

el see Tokens.

Reset Styles Resets the text options to the default.

There are three choices for how the text displays on the screen
Static - The alert is stationary on the screen.

Display Method Scrolling - The alert will scroll across the screen.
Scroll when needed - The alert will scroll only if the text is so long
that it doesn't fit the screen.

When you choose a static display, select the desired alignment of

Text Alignment the text.

Choose the number of times the alert should display from 1-9. You
can also choose to display the alert until you manually remove it, or
until a specific token expires. If you choose to display the alert until a
token expires, the Token Name field will become active.

Display Count

Select the token whose expiration will correspond to the display

Token Name count for the alert.
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Tokens

A token is essentially a variable that you can insert into an alert. To create a new token, click
the Tokens drop-down and select Add. The Add/Edit Token window will appear.

1. Enter a name for the new token.

2. Select the type of token from the Type drop-down. Depending on the type chosen,
other fields will appear in the window as shown in the table below. For the "count-
down" tokens, an Allow Overrun check box will appear. Check this box to have the
countdown clock start counting with a negative time to show that you have overrun
the starttime.

No additional fields. Enter the text to display in the

Text
alert.

This inserts a clock using the time your computer is
set to, into the alert, using the format chosen in the
Format field. Options are (each example shows the
format for 11:30 PM):

hh:nn-11:30
Clock hh:nn:ss - 11:30:01
hh:nn am/pm - 11:30 pm
hh:nn:ss am/pm - 11:30:01 pm
HH:NN - 23:30
HH:NN:SS - 23:30:01
custom - If custom is chosen, a Custom Format
field appears. Enter the desired format.

This will insert a countdown to the start of service,
based on the service intervals entered in the Service
Intervals tab of the Options window. An additional
field, Format, appears with the following options:
nn:ss

hh:nn

hh:nn:ss

hh:nn{ss}

Countdown to Service Start

This will insert a countdown to the end of service,
based on the service intervals entered in the Service
Intervals tab of the Options window. The count-
down will start at the greater of 1/3 service interval

Countdown to Service End
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Countdown Timer
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length or 15 minutes. An additional field, Format,
appears with the following options:

nn:ss

hh:nn

hh:nn:ss

hh:nn{ss}

This will insert a countdown to the start or end of ser-
vice, whichever is applicable, based on the service
intervals entered in the Service Intervals tab of the
Options window. The countdown to service end will
start at the greater of 1/3 service interval length or 15
minutes. An additional field, Format, appears with
the following options:

nn:ss

hh:nn

hh:nn:ss

hh:nn{ss}

This will insert a countdown to the time entered in
the additional field (Time) that appears when this
option is chosen. An additional field, Format,
appears with the following options:

nn:ss

hh:nn

hh:nn:ss

hh:nn{ss}

This will insert a countdown for the amount of time
entered into the additional field (Time) that appears
when this option is chosen. An additional field,
Format, appears with the following options:

nn:ss

hh:nn

hh:nn:ss

hh:nn{ss}
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R L | =
Live Alert Editor >
\j&iithler‘c X 3
Ill Alert Mame |Countdown |
4 Countdo| Message Hide
MensGrol [T con iy Cvm 1 v s (0] Tekens - | Resetsiyes
Womens| =
CD_END | until the service is complete CD_END
Add/Edit Token *
Mame | | :
J Display Method |5t 1YPE = >
Text Alignment | CH Clock
| | Countdown to Service Start Add Edit
R | = Countdown to Service End
Countdown to Service Start/End --ancel
Countdown to Specific Time s
Countdown Timer
Fall Aspen Ferm Leat Bl Festive Candles FIFEmgt Tobon Falls GIve Glory
Foldback Alerts

You can also display messages to the foldback (stage display). Create and edit these mes-
sage just like the General Message Alerts in the Live output.
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Announcement Loops

Announcement loops are a great pre- or post-service communication tool. Whether you're
sending announcements to a lobby kiosk or presenting on the main screens in your
auditorium, this article will show you how to get started.

Slide loops are created in the Presentations Area of EasyWorship. When you're ready to
play the loop, simply drag-and-drop it to the Schedule Area and click Go Live, or just
double-click it to send it to the screen. The slides within the Presentation will loop until you go
live with the next item in the Schedule.

Using the Slide Master to set Transition Times

1. Create a new presentation (click the Presentations tab in the Resource Area and
clickthe 4 - icon).
« ORright-click an existing presentation and select the option to Edit Item.

2. Once the Presentation Editor opens, click Inspector in the top-right corner.

3. Click Presentation on the left and check the box to Loop Presentation.

# L4 a8 |

B Presentation Editor - Untitled a |3 2@]

Presentation Attributes

- N
Aspect Ratio | Auto -

¥ Bbop Presentation
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4. Close the Inspector and select the Slides tab.
5. Click Slide Master at the bottom-right of the Slides tab.

Tahoma | [Auto

Words Slides

il lcreatures of our

b;ft up ¥olr voice

Fand with us'sing,
Alleluia! Alleluia!

,snft‘er'all_eam,

F O'praiselHim, .0
praise Him!

Alleluia! Alleluia! Alleluia!

. s =

Select the Master Slide (first slide at the top).
Open the Inspector and select Transition under the Slide settings.

Set the transition and any other desired options.

© ® N o

Select the Slide tab and set the desired Slide options:
= Advance Slide
« On Click advances the slide when you click the mouse.
« Automatically advances the slide automatically after the set time.

« Delayed advances the slide when the media on the slide has finished
playing.
= After - Set the number of seconds you wish to wait before transitioning to the
next slide.

m Loop Slide - Set the slide to loop continuously until you select another slide.
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= Always start slide from beginning - Set the slide to always play all elements
from the beginning.

Close the Inspector.
Click Master Slide again to turn off the slide master view.

All slides will be updated by this change. If you want to modify the time for a specific
slide, select that slide and use the Inspector to change the timing.

Add as many slides as desired. Then, enter a name for the presentation in the Title
field and click OK to save.

NOTE These instructions apply only to EasyWorship presentations, songs, and scriptures.
PowerPoint loops cannot be set up using these instructions.
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Collections

Collections help you keep your resources organized in EasyWorship. Collections are
available in all of the tabs in the Resource Area. Resources listed under Collections are
available to all EasyWorship users sharing a network database. The resources under My
Collections are only available on that computer.

\ Sungs. Scriptures  Media  Presentations  Themes

= A Heart Like Thine Title

SONGS A Heart Like Thine
] A Mighty Fortress |
A New Name In Gl
A Robe Of White
Abide With Me
Alas And Did My 5
All Creatures Of Cu
All Hail The Power

All People That On
Allzliia Allaliia
g v | $Fw L i3

I COLLECTIONS
MY COLLECTIONS

Songs, Scriptures, Presentations, and Themes Collections

1. Tostartusing Collections, select the desired tab (Songs, Scriptures, Media,
Presentations, or Themes) in the Resource Area and click the + icon. The Col-
lections menu shown here will appear.
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Songs | 5c riptures  Media  Presentations Theme

- Titl
SONGS
All 5engs
4 COLLECTIONS
Efl Christmas
Easter
Thanksgiving
4 MY COLLECTIONS

%I‘:d%}' i

Mew Folder

Mew Collection

Mew My Folder
Mew My Collection

54

2. Folders help organize your Collections. For example, you can have a Holiday folder
with separate Collections for various holidays. To edit the Collection, double-click
the desired Collection or right-click the Collection and select Edit.... This will open

the Edit Song / Scripture / Presentation / Theme Collection window.
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[ Edit Song Collection

Song Collection

Edit collection rules

Mame

|Chri5tmas

[ Match | Al « | of the following rules:

Any Field ~ | contains « | |Christmas

Cancel

3. Inthis window, you can edit your Collection name and filter your Collection con-
tents. Check the box next to Match and use the drop-down to choose All or Any of

the following rules.

4. Using the drop-down menus, select the desired options and enter the text by which to
filter your results. You can filter by Title, Author, Copyright, Administrator, Words, or
Any Field. Click the + icon to add additional filters to this Collection.

5. Click OK tofilter the songs in the Collection and return to the main window. You will

see the filtered results now contained in that Collection.

Songs = Scriptures  Media  Presentations Themes

= Go Tell It On The Mountain Title Author

[ Thanksgiving
4 MY COLLECTIONS

Copyright
SONGS Go Tell It On The Mountain John W. Jr. Work Public Domain
[2=] All Songs | Heard The Bells On Christmas Day Henry W. Longfellow Jean Baptiste Calkin Public Domain
4 COLLECTIONS O Christmas Tree Public Domain
4 [ Holiday O Little Town Of Bethlehem Lewis H. Redner Phillips Brooks Public Domain
Our Day Of Joy |s Here Again Andrew L. Skoog Public Domain
|_13 Easter

v | B 4| kv 1of 5s0ngs

o

NOTE Addingitems to a Collection does not copy them to a folder. If you delete the source

image, it will be deleted permanently. You cannot undo this action.
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Media Collections

Using Collections in Media will help keep your own images and videos organized. In the
Media tab, create a new Collection. You can then drag-and-drop media from the Images
and Videos sections to your new Collection.

Songs  Scriptures | Media | Presentations  Themes

Q- Title File Name

|5 videos L
(1] Images |

EH Feeds

m
g
LI

07 Caesar Au... 16-9-Pine_Sil... 16-9-Pine_Sil... 22 Anna Sees ... Acts Blank Acts Title Autumn Light
@ZVE _,.---"""""' L L T T T T
%3] Audio | )
4 COLLECTIONS 'z - L - ¥
X Lottt ﬁ - - - - h i
[H General —_—— —_— -

Blue Tree Spa... Blue Waves Book of Mark... Cardinal In W... Christmas-20...

"‘ S —
! Beach Sunrise Blue Paint
[ Folday Sestonalh o

[ Text Backgre inid

Ia)
o
3
El

MY COLLECTIONS WELCOME i.
ud !
Cross 3 Cross In Light... Cross Sunrise Cube Frenzy Fall Aspen Fern Leaf Blu... Festive Candles Firelig

ES I 11 s T T sl

Also, if you already have your images and videos organized into folders, you can retain that
structure within EasyWorship using the Collections filter.

1. Click Profiles > Profiles Manager.... The Profile Editor window will appear.

2. Click the link next to the Instance Location. This will open your EasyWorship Profile
folder.

3. Double-click Resources and select the folder for the type of media you want to organ-
ize. Keep this window open while editing your Collection, so that you can see the
available directories.

4. In EasyWorship, close the Profile Editor and click the + icon to create a new Col-
lection. Right-click the newly created Collection and select Edit.... The Edit Media
Collection window will appear.

5. Enter a name for your Collection, likely the same as the directory you'll be pulling
media from.
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[# Edit Media Collection

l' j Media Collection
Edit collection rules

Marme

| Cru:usse5|

[~ Match | All ~ | of the following rules:

In these media types Videos e

Directory ~ | contains ~ | |Crosses = dh

Cancel

6. Check the box next to Match and select All. Change the media type to the type of
media you're filtering. Click the Title drop-down and select Directory. Enter the dir-
ectory name. Click OK to populate that Collection with the media from the specified
directory.
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Compose

For on-the-fly editors and designers, Compose is the quickest way to apply atheme to a
song or scripture at the last minute. In the Compose section, you can choose to send an item
to the live screen immediately, or add it to the Schedule for later.

B EasyWorship - Your Church - Default
File Edit Live Profiles View Help

~ 4+ Live - What Wondrous Love Is Thi

p

8 l
Sl

What wondrous love is this,
O my soul, O my soul!
What wondrous love is this, O my soul!
What wondrous love is this
That caused the Lord of bliss

E
sso:@dgd3550%
=
2

) Audio 95 A Psalm Of Prai AirBall Autumn Dreams

couEcrions
MY COLLECTIONS n
7 I.I.E'I'lll
04:56

MR- * Tof 68 tems

The location and presence of Compose depends on the selected view in Easy Worship. For
more information about the views available in EasyWorship, see Interface Views.
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Display Foldback (Stage Display)

If you want to take advantage of the Stage Display (Foldback) feature in EasyWorship, this
article will explain what you need to get started along with step-by-step setup instructions.

What Is Display Foldback?

Your audience is first, but your stage needs support, too. While the audience sees the
presentation on the main screens, Stage Display lets the stage see a custom display with the
current presentation or video, a preview of the next scheduled item, a clock and private
alerts. This goes for PowerPoint presentations as well. EasyWorship even lets the stage see
variable thumbnails for previous, current, and next slide.

Hardware Options

In order to use Display Foldback in EasyWorship, you will need one of the following
hardware solutions:

Desktop Computer

NVIDIA GTX video cards are recommended because they offer the ability to use one video
card to support three to four screens. This configuration provides the best performance and
easiest configuration.

Laptop Computer

We recommend using a laptop with a NVIDIA GTX video card, but normally you will only
have one video port on the laptop. A Matrox DualHead2Go box is required to connect the
front of house and foldback screens to the laptop.

See the System Requirements for EasyWorship 6 article in our Knowledge Base. This will
help you to find the best video cards to use for Stage Display purposes. You can order any
one of these online from NewEgg.com or amazon.com.

Setup for NVIDIA GeForce GTX Video Card

Set Up Video Card and Windows
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1. Connect the front of house video cable to one of the video ports on the video card.
2. Connect the foldback video cable to another video port on the video card.

3. Extend the Windows desktop to the secondary and third monitors. Click here for a
video tutorial.

Set Up EasyWorship

1. In EasyWorship, click Edit > Options.

2. Under the Live Optionstab, click the Output Monitor drop-down, then select the
monitor you wish to use for the Front of House display.

3. Click the Foldback tab on the left and check the box to Enable support for display
Foldback (stage display).

4. Under Select Output Monitor, select the monitor you wish to use for Display Fold-
back.

5. Click OK. Display Foldback has been configured.

Setup for the Matrox DualHead2Go

When using a Matrox DualHead2Go box, the secondary output from your computer's video
card plugs into the input on the Matrox box. The Matrox box also has two outputs that are
spanned across two monitors/projectors/tv’s. The screen resolution for that output is double-
wide. If that sounds too technical, here are some examples that should help you picture how
it works.

Example 1

Imagine you have two projectors. You know that one is for the audience and the other is
projecting onto the back wall for the stage to see, but Matrox just sees these as two outputs
side-by-side. Now, if each projector has a resolution of 1024x768 (that's 1024 pixels wide
and 768 pixels tall), then together (side -by-side) the resolution will be 2048x768. When you
connect the Matrox box to the two projectors, the combined resolution will be 2048x768.
That's all the Matrox box needs to know. EasyWorship will communicate that to the Matrox
box, as well as which graphics and words to send to the first projector for the audience, and
which graphics and words to send to the projector for the stage. As long as you set
EasyWorship up correctly, it will take care of telling the Matrox box what to do.
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Example 2

Here's another example using a simple diagram (below). Imagine two pieces of paper next
to each other where the left piece (piece 1) is what goes to your computer monitor and the
right piece (piece 2) represents what the Matrox box is sending to the two projector screens.
Since the output resolution on piece 2 is double-wide, we can split it in the middle and send
the first half to the first projector for the audience and the second half to the second projector
for the stage to see.

0 4 8 14
piece 1 piece 2
Manitor 1 Monitor 2 (Matrex DH2G)
[Cempuier Monides) [Froat of Houss) |Feddbach)

Finding_; Left Positions

To tell the Matrox box what it needs to make Display Foldback work, EasyWorship needs to
know the left position of the Front of House screen, the left position of the Display Foldback
screen, and the width and height of both.

1. Left Position for Front of House: To find the left position for the Front of House screen
(piece 2), we just need to know the width of Monitor 1 (piece 1). In the example above,
the width of piece 1 is 4. Piece 1 goes from 0 to 4, so piece 2 starts its left position at 4.
Not too bad.

2. Left Position for Display Foldback Screen: To find the left position of the Display
Fodlback screen (second half of piece 2), we need to know the distance from the left
side of piece 1 to the middle of piece 2. We will add the width of piece 1, which is 4, to
half the width of piece 2, which is 5 (or 4+5=9). So, in the example above, the left pos-
ition of the Display Foldback screen would be 9.

-61-



EasyWorship 6 User Guide 62
General Topics

If you were using the numbers from the above diagram to set the custom positions in
EasyWorship, the left position for the Front of House screen would be 4, and the left position
for the Display Foldback screen would be 9. The width for each would be 5 since they are
both using half of the secondary monitor resolution (10/2=5). The height would be whatever
the height is from the resolution setting.

Now, let's look at how this simple illustration works with actual monitor resolutions.

Finding Width and Height of Both Monitors

Now, we can replace the numbers from the example above with the actual numbers from the
resolutions your monitors and projectors are using.

1. Right-click the Windows desktop.

o Windows Vista users will select Personalize then click the Display Settings link.
o Windows 7 and 8 users will select Screen Resolution.
o Windows 10 users will select Display Settings.

2. Click each monitor to determine its resolution (width and height). The size will be dis-
played in the Resolution Area, e.g., 1024x768, 1920x1080, etc.

Example Screen Resolutions (below):

1. Monitor 1: 1024 pixels wide by 768 pixels high (1024x768)
2. Monitor 2: 2048 pixels wide by 768 pixels high (2048x768)

1024x768 2048x768

IMPORTANT! These resolutions may be different on your computer. Write this information
down for use in the steps under Front of House Settings and Foldback Settings. If the second
monitor is not already set to a double-wide resolution, change the change the resolution in the
windows display settings to a double-wide resolution.

Common double-wide resolutions to use:
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Standard 4:3 - 1600x600 or 2048x768

2. Widescreen 16:9 - 2560x720
3. Widescreen 16:10 - 2560x768

If one of these resolutions is not available, you may need to contact Matrox Technical
Support (www.matrox.com/graphics/en/support/).

Front of House Settings

1.

In EasyWorship, click Edit > Options....

2. Under Live, click the Output Monitor drop-down, then select Custom Position.

4.

In Output Position, set Left to the width of Monitor 1, set Top to 0, set Width to half
the width of Monitor 2, and set Height to the height of Monitor 2.

Click OK.

Using the example illustration below, your custom position settings in EasyWorship for Front
of House (Live Output Monitor) would be the following:

1. Left: Width of Monitor 1 = 1024
2. Top:0

3.

4. Height: Height of Monitor 2 = 768

Width: Width of Monitor 2 (2048) divided by 2 = 1024

Primary  Front of House Foldback

1024x768  1024x768 1024x768

NOTE Itis unlikely that your screen resolution will match the example above. To determine
the values needed to correctly set up EasyWorship for your situation, see "Finding Left
Positions" on page 61 and "Finding Width and Height of Both Monitors" on the previous page
above.
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Foldback Settings

1. In EasyWorship, click Edit > Options....

2. Under Foldback, check the box to Enable support for display Foldback (stage
display).

3. Under Select Output Monitor, select the monitor you wish to use for Display Fold-
back. This is usually Monitor 3 from the list next to Output Monitor.

4. In Custom Position, set Left to the width of Monitor 1 + half the width of Monitor 2,
set Top to 0, set Width to half the width of Monitor 2, and set Height to the height of
Monitor 2.

5. Click OK.

Using the example illustration below, your custom position settings in EasyWorship for
Foldback would be the following:

1. Left: Width of Monitor 1 (1024) + half the width of Monitor 2 (1024) = 2048
2. Top:0

3. Width: Width of Monitor 2 (2048) divided by 2 = 1024

4. Height: Height of Monitor 2 = 768

Primary  Front of House Foldback

1024 + 1024 = 2048 Left
Position

NOTE Your screen resolutions probably will not match the example above. To determine the
values needed to correctly set up EasyWorship for your situation, see Finding Left Positions
and Finding Width and Height of Both Monitors instructions above.

Back to Top

Matrox DualHead2Go Connection Examples

The Matrox DualHead2Go can support a maximum of two outputs: either two Front of
House outputs or one Front of House output and one Display Foldback output. If you need a
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Display Foldback output as well as two Front of House outputs, you'll need to add a splitter to
your setup. Here are two illustrations that show the Matrox DualHead2Go without a splitter
(for Display Foldback and one Front of House output) and with a splitter (providing Display
Foldback and two Front of House outputs).

Without a Splitter

Foldback

0)
/N

11

Matrox / || \‘
Front Of House

With a Splitter

Foldback

0
71N
= N /x

7T 7N

FOH 1 FOH 2

1]

In the diagram below, a switcher has been added to the configuration, allowing you to show
either the Foldback view on the Foldback screen or the Front of House view on the Foldback
screen.
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DVD Clips

Intro to the DVD Feature

EasyWorship lets you use your computer's DVD drive to show segments of a DVD during a
presentation or service, e.g., a missions update, sermon illustration or service intro. Quickly
select entire segments or chapters of a movie, or set custom In and Out points to show only a
short clip. EasyWorship was not designed to copy or burn video files from a DVD. Instead,
EasyWorship lets you create custom "markers" that tell EasyWorship exactly what to play
from the DVD. That means the DVD has to be in the DVD drive for this feature to work.

Layout

To start exploring the DVD feature, click the Media tab in the Resource Area. Then, click
the DVD icon in the Media Library (see illustration below). There are three icons across the
bottom of the DVD clip library.

1. Add New = :Click thisicon to openthe DVD Clip Editor window and create a new
DVD clip.
2. Action i~ : Clickthisicon to add a new DVD clip, edit or delete a selected clip, cus-

tomize the thumbnail view, customize the clip sort order, or refresh your clips.
3. Thumbnail View E:: =: Click this icon and use the slider to customize the thumbnail

view in the DVD clip library.

Songs Scriptures  Media | Presentations  Themes + »
Q- Title File Name
MEDIA

& Videos

=] Images

EH Feeds

[43] Audio

COLLECTIONS

MY COLLECTIONS
| v 4 | & 0 items BE:

DVD Clip Editor Overview

To access the DVD Clip Editor, right-click anywhere in the DVD clip library section and
select Add New DVD Clip... from the pop-out menu, or click the Add New = icon.Ifa

DVD is in the DVD drive when the DVD Clip Editor window pops up, EasyWorship will begin
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playing the DVD just like a normal DVD player. Using your mouse, click the chapter menu in
the preview window and navigate to the desired chapter or segment. The DVD Clip Editor
gives you a number of options for selecting clip segments and adjusting clip volume.

For step-by-step instructions on creating a DVD clip using the DVD Clip Editor, see Create a
DVD Clip.

Properties Tab

[ DVD Clip Editor = [ -E-][wE3a)

DVD Clip Editor
Lt~ Create and manage DVD clips for use in EasyWorship

PROPERTIES INFO

Clip Properties
: MarkIn |

000000 .00
@ Mark Entire Segment |

Aspect Ratio

Aspect Ratio |Automatic vm

’  26:49 / 40:25 Audio Properties
9000 o

W) O ' @‘u’olume [J w0 £ Mute

| Select !rive v| [ Ok ] | Cancel

1. Play / Pause: The play/pause button starts and stops the video playback.

2. Fast-Forward / Rewind: Single clicking skips forward or backward one chapter. Hold-
ing the FFW or RWD buttons down will fast forward or rewind the video.

3. Menu: Allows you to access the DVD Title Menu, Root Menu, set subtitle options,
Audio options angle and load the chapter menu.

4. Continuous Play / Repeat: Allows you to loop the DVD clip you are viewing or let it
stop at the end of the clip.

5. Mute & Volume: Controls the audio while working with the DVD clip. The audio will
not be muted on playback.

6. Select Drive: Select the DVD drive that currently has a DVD disk in it. This is auto-
matically selected if you only have one DVD drive.

7. Title: Type the name of the DVD clip in this field.
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Thumbnail: Click the thumbnail box on the right to set the thumbnail. (This takes a
snapshot of what is currently in the player window)

Clip Properties: Start Position is the time at which the DVD clip will start. Use the up
and down arrows to manually adjust the time. Mark In sets the start position of the
DVD clip. Click this button as the DVD clips plays to set the start position. End Position
is the time at which the DVD clip will end. Use the up and down arrows to manually
adjust the time. Mark Out sets the end position. Click this button as the DVD clips plays
to set the end position. Reset simply resets the Start and End Points.

Mark Entire Segment: Selects the whole DVD, or in the case of an iWorship DVD,
selects the start and end point of the song you are currently viewing.

Aspect Ratio: Allows you to maintain the aspect ratio, stretch or zoom the video.

Audio Properties: Allows you to change the volume of the DVD clip when you go live
with it. The volume slider allows you to set the volume of the DVD clip for playback to
the audience. Mute allows you to mute the audio on the DVD clip if you don’t wish to
use the audio portion of the DVD.

Info Tab

> DVD Clip Editor o [ 2=

DVD Clip Editor
Create and manage DVD clips for use in EasyWorship

(S

26:49 / 40:25
P o = o) O
Select Drive v | OK | Cancel

PROPERTIES | INFO

Title (1]

Author 9

copyright  (€) (4 15)
G oecipiion | () Tags -

1.
2.

Title: Enter the name of the DVD clip in this field.
Author: Enter the Author in this field.
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. Copyright: Enter copyright info in this field.

3

4. ©: Adds the copyright logo to the copyright field.
5. Description: Enter a description for the DVD clip.
6

. Tags: Enter tags for the clip.

Create a DVD Clip

1. Inserta DVD into the DVD drive.

2. Clickthe Media Tab in the Resource Area.

3. Clickthe DVD icon in the Media Library on the left.

4. Right-click anywhere in the DVD clip library section and select Add New DVD Clip
from the pop-out menu, or click the Add New .- icon at the bottom of the DVD clip
library section. The DVD Clip Editor window will appear.

5. Type aclip name in the Clip Name field.

6. Using your mouse, click the DVD chapter or title menu in the preview window and nav-
igate to the desired chapter or segment.

7. Asthe selected DVD clip plays, click Mark In to select the beginning of your clip.
8. Click Mark Out to select the end of the clip.

9. The Preview button will allow you to preview your edited clip in the window. Click Edit
to resume editing.

10. Scroll the clip to find the frame you wish to use for a thumbnail and click Set Thumb-
nail. Click OK.

11. The clip and thumbnail will appear in the DVD clip database.

NOTE To play an entire chapter or segment, click Mark Entire Segment. For Integrity
iWorship DVDs, and others like it, you can click Mark Entire Segment when a worship track
starts playing. EasyWorship will set the Mark In and Mark Out points at the beginning and end
of the song for you.

WARNING! If the wrong region or no region is set for the DVD drive in your computer, you will
be able to create clips, but will NOT be able to play them back after removing and reinserting the
DVD into the drive. To learn how to set the region for your computer's DVD drive, see Setting

DVD Region below.
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Using a DVD Clip in the Schedule

1. Selecta DVD clip in the from the DVD section of the Media tab.
2. Drag-and-drop the clip into the Schedule.
3. Whenitis time for the DVD clip to be played in the service, click Go Live.

NOTE Togo live witha DVD clip directly from the database, double-click the clip. DVD clips
can be transferred via the schedule to another computer, but the DVD has to be in the drive for
the clip to play.

Edit a DVD Clip

1. Right-clicka DVD clip in the from the DVD section of the Media tab.

2. Select Edit.

3. The DVD Clip Editor window will appear. Make the desired changes.
4. Click OK to apply the changes.

Delete a DVD Clip

1. Right-clicka DVD clip in the from the DVD section of the Media tab.
2. SelectDelete.
3. Click Yes on the prompt that appears to verify that you want to delete the clip.

Setting the DVD Region

In order to create DVD clips in EasyWorship, the DVD region has to be set on the DVD
player in the computer. Many DVD drives come from the factory with no region set. If the
wrong region or no region is set, you will be able to create clips, but will not be able to play
them back after removing and reinserting the DVD into the drive. Follow the instructions
below to set the region on the DVD drive in the computer.

1. Open Computer or My Computer or This PC.
2. Right-click the DVD drive.

3. Click Properties.
4

. A properties window will appear.
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5. Click the Hardware tab.
6. Selectthe DVD drive from the list.

7. Click Properties at the bottom. The Properties window for the DVD drive will
appear.

8. Click Changes settings at the bottom of the General tab.
9. Clickthe DVD Region tab.

10. Select the appropriate country.

11. Click OK.

NOTE The DVD region can be changed a maximum of 5 times.

DVDs Explained

EasyWorship lets you use your computer's DVD drive to show segments of a DVD during a
presentation or service, e.g., a missions update, sermon illustration, or service intro. Quickly
select entire segments or chapters of a movie, or set custom In and Out points to show only a
short clip. This is different than capturing a DVD feed through a capture card. It's also
different than copying or burning video files from a DVD. Instead, EasyWorship lets you
create custom "markers" that tell EasyWorship exactly what to play from the DVD. That
means the DVD has to be in the DVD drive for this feature to work.

DVD Structure

The video contentin a DVD is divided into titles and menus. Titles are further divided into
units called parts of titles (PTTs). More often, these are called scenes, chapters, or
segments. These could be compared to using folders and sub-folders in the directory tree
structure of a computer. The viewer can navigate to specific titles or chapters within titles.
Each individually separated video file on a DVD may be referred to as a segment.

The author of a DVD decides how to divide the content into titles and chapters. When a DVD
contains a feature-length film, the entire film is often placed in one title or segment, and
sometimes divided into chapters for the individual scenes. Extra features on the DVD, such
as trailers or deleted scenes, are placed in separate titles or segments. However, these
divisions are arbitrary, and many DVDs are organized differently.

The EasyWorship DVD editor can play the entire movie, predefined segments, or you can
select parts of the DVD called clips. On any DVD, you may set Mark In and Mark Out points
to edit a clip. You may define a clip name for that edited clip. The DVD from which you wish
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to play a clip must remain in the DVD-ROM drive. EasyWorship does not copy the DVD or
segments, only a path to turn on that selected segment or clip. If you have multiple drives,
EasyWorship will remember the drive from which you edited your specific clip. Multiple clips
or segments may be chosen from your DVD.
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Feeds

EasyWorship can project images from your computer through external devices (e.g., DVD,
VHS, Camera[s], Mixer) using a capture card. Most capture cards are PClI cards that are
installed into PCI slots on the motherboard of your computer. Each capture card has its own
input connections. Some are RCA (composite) jacks, some are S-video, and some are
FireWire IEEE1392. Itis important that you determine the type of interface cable desired
before you order your capture card.

NOTE FireWire IEEE1392 has some latency that is noticeable. This option may not be
desirable if your audience is watching the source and output screen at the same time (e.g.,
IMAG). Some capture cards do not work well with multiple cards of the same type. See System
Requirements at EasyWorship.com/Support.

Add a Feed

1. Open EasyWorship.

2. Inthe Resource Area, click the Media tab and select Feeds from the Media Library
on the left.

3. Click the Action Menu button ##~ at the bottom of the List Area in the middle.

4. Selectthe option to Add New Feed, which brings up the Feed Editor window.

5. Under the Available Input Devices you will see <unassigned> and below that you
will see any input devices that are connected (e.g., a capture card, aweb cam, or a
USB input device).
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W Feed Editor = O

—= | Feed Editor
Create and manage feeds for use in EasyWorship

Name 2
L

Available Onput Devices

Input Device <unassigned> v

Device Options

Aspect Ratio

Aspect Ratio Automatic v
bR Audio Properties
Volume ' 100 = [IMute
3\ Device not connected! Close

6. Click the input device to which you want to connect.
7. Type a name for the device in the Name field. Example: Webcam.

8. Cllick the camera icon to select the type of device (options include a Camera, Mixer,
DVD player, and Misc Player).

9. Under the Device Options you can customize the following properties:

« Resolution: Defaults to 640 x 480, but can be changed from 1280 x 720 to 160 x
480.

o Frame Rate: Defaults to 30 FPS.
o Color Space: YUY2 or MJPG.
« Video Standard: NTSC or PAL. This setting is automatically populated.

« Aspect Ratio: defaults to Automatic, but can be changed to Maintain, Stretch, or
Zoom.

« Audio Properties: allows you to change the volume of the feed when you go live
with it. The volume slider allows you to set the volume of the feed for playback to
the audience. Mute allows you to mute the audio on the feed if you don’t wish to
use the audio portion of the feed.

10. Click OK when you are done.
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11. The added device is listed in the Feeds Library in the Resource Area. To add addi-
tional devices repeat steps 1-10.

Edit a Feed

1. Inthe Resource Area, click the Media tab and select Feeds from the Media Library
on the left.

2. Inthe List Areain the middle, right-click the device and select Edit. The Feed Editor
will open, providing the same options described above.

3. Make the desired changes and click OK.

Delete a Feed

1. Inthe Resource Area, click the Media tab and select Feeds from the Media Library
on the left.

2. Inthe List Area in the middle, right-click the device that you want to delete and select
Delete.

3. A message appears asking you if you want to permanently delete the feed.

4. Click Yes to delete the feed.

mht-CIick Features

When right-clicking a thumbnail in the Feeds Resource Library, you have the following
options.
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Songs  Scriptures | Media | Presentations Themes

Q- Title
MEDIA
= Videos
=] Images
CH Feeds
(=) DVD
[41] Audio
COLLECTIONS
MY COLLECTIONS

Add Mew Feed...
Edit Feed...

Copy to Theme -]

Set As Loge Background

Delete
View ¥
Sort by »
Refresh

1. Add New Feed...: This will open a blank feed in the Feed Editor.
2. Edit Feed...: This will open the selected feed in the Feed Editor.

3. Copyto Theme >: Select Song Theme, Scripture Theme, or Presentation Theme to
add the feed to the desired theme library.

4. Setas Logo Background: sets the feed as the default background logo. Clicking the

Logo button in the Toolbar will output the logo you selected to the screen. Clicking it
again turns off the logo.

5. Delete: deletes the feed from the Resource Area. It will prompt you to delete it com-
pletely from the / Resources / Feeds folder.

6. View: allows you to change icon size for a custom thumbnail view.
7. Sort by: the same as in Windows.

8. Refresh: This will refresh the thumbnails for the selected item.
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# EasyWorship - EasyWorship Support - Default = HEh ===
File Edit Live Profiles Help
" | I B @ =d = | = L
Open Save New  Web Go Live Logo Black Clear Live
Schedule - 141207 Worship_2nd... I v | &~ | Live - We Will Glorify 2% = | Live Output =

- We Will Glorify 2
s And Did My Savior
-' Genesis 1:1 (HCSB)
“ 6770

o come ™

—
(-

Versel Verse2

We will glorify the King of kings
We will glorify the Lamb

We will glorify the Lord of lords
Who is the great T Am

Verse 3

Versed

Scriptures  Media = Present

Slide 1 of 4 >

File Name

L1 N =

15457 15458 16288

‘ ‘1‘
9309

1 of 27 items g

6770 8817

Display Images

In the Resource Area:

1. Click the Media tab.

2. Clickthe Images icon in the Resource Library below, then drag and drop the image
to the Schedule Area.

3. Select the image in the Schedule Area and click Go Live, OR double-click the image
to go live to the audience.

Add New Images

EasyWorship comes with a set of images ready for you to use in your presentations. But
more than likely you'll want to add new background images that you've purchased online or
produced yourself. Here's how to add new images to your Images Library.
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Click the Media tab.

Select Images in the Resource Library on the left.

In the Images List Area (below Image thumbnails), click the +icon | + .
Browse to the image you want to import and select it.

Click Open.

The imported image appears in the Images List Area.

© o kA w0 bdh =

NOTE EasyWorship will display .bmp, .jpg, .wmf, png, and .ico files. For the best results,
store all images in Your Profile/images folder. To find out how to locate your images folder, see
"Profiles" on page 181 and scroll down to the section titled "Locate Your Profile Data."

@ht-Click Features

When right-clicking a thumbnail in the Images Resource Library, you have the following
options.

Songs  Scriptures . Media. Presentations  Themes

@ ¥ Search Any Field Title
MEDIA
[ Images I
EX Feeds " Import New lmage File... ]
@ DVD Edit Image Properties...
[11] Audic Copy to Theme ]
COLLECTIONS l:‘ Set As Loge Background
MY COLLECTIONS =
Cross 3 Delete o
— View *
Sort by »
h Refresh
Hallalisizh Ha Hiddan- Wat Himk

1. Import New Image File...: this is a shortcut for adding additional images.

2. EditImage Properties...: opens the Image Properties Editor, which allows you to add
a title, control the default aspect ratio for the image, and more.

3. Copyto Theme >: Select Song Theme, Scripture Theme, or Presentation Theme to
add the image to the desired theme library.
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4. Setas Logo Background: sets the image as the default background logo. Clicking the
Logo button in the Toolbar will output the logo you selected to the screen. Clicking it
again turns off the logo.

5. Delete: deletes the image from the Resource Area. It will prompt you to delete it com-
pletely from the / Resources / Images folder.

o

View: allows you to change icon size for a custom thumbnail view.

N

Sort by: the same as in Windows.

Refresh: This will refresh the thumbnails for the selected item.

o

Drag & Drop Features

3 EasyWorship - Default E@
File Edit Live Profiles Help
SR~ R | = =B LA
Open Save New Web Go Live Logo Black Clear Live

Schedule - 141207 Worship_2n... 57 v | %~ | Live - We Will Glorify & ¥ | Live Output

" We Will Glorify

3
“j‘ Alas And Did My Savior BL...

p—

Versel

We will glorify the King of kings
We will glorify the Lamb

Genesis 1:1 (HCSB)

We will glorify the Lord of lords
Whois the great I Am

Es??o F B

| N
o
hpm_are you smarter L.y,

b 02 Healer
Slide 1 of 4 >

e 7 comeT™

Songs  Scriptures  Media | Presentations Themes Q- + >
MEDIA Title B . \File Name
| Videos B
(4] Images
=N Feeds fo_snow fallin... ... hpm_christ 3. im_ib05_colors...  img kaleidoor...
& DvD E
-
(5] Audio a2l
COLLECTIONS 2 ‘ ‘ ‘
MY COLLECTIONS = k\
= \
mop_inside to...  pgm_blue and... AW swoutumnsu..  sw bluerushS..
b | B o2 g 1 of 14 items ae v

1. Addto Schedule: Drag and drop an image into the schedule from the Images list.
2. Use as Background: Drag an image onto a song in the schedule to assign that image
to a song as a background.

3. Add a New Image: Drag and Drop images from any folder in Windows to the images
list. EasyWorship will then add a shortcut to that image into your images tab.
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Image Properties Editor

Follow these steps to edit the properties of any image in EasyWorship:

1. Click the Media tab in the Resource Area.

2. Selectlmages from the Resource Library on the left.
3.
4

Right-click any image and select the option to Edit Image Properties.

. The Image Properties editor will appear, allowing you to customize properties of the

image such as title, aspect ratio, copyright information, tags, etc.

Properties Tab

. Title: Enter the name of the image in this field.

Media Usage:Changes how the background image behaves.

Selecting the Picture icon stretches the image to fill the screen and loops.

Selecting the Movie icon does not stretch the video or image and does not loop if the
background is a video.

Aspect Ratio: Allows you to maintain the aspect ratio, stretch, or zoom the image.

Info Tab

. Title: Enter the name of the image in this field.

Author: Enter the Author in this field.

©Button: Enter copyright info in this field. Pressing the copyright logo button adds the
copyright logo to the copyright field.

Description: In the drop-down field, enter a description for the image (description
keywords are searchable from the search bar in the Resource Area).

Tags: In the drop-down field, enter tags for the image (tags are searchable from the
search bar in the Resource Area).

OK: Saves the Image properties and closes the window.

Cancel: Cancels all changes and closes the window without saving.
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Inspector

The inspector is available from the Song Editor, Presentation Editor, Theme Editor, and
Schedule Editor. It allows you to make additional formatting changes to selected elements.

B Song Editor - A Mighty Fortress Is Our God [m} ps
A Mighty Fortress Is Qur God | = 0
B T O . 5| @
K+ s o Theme Text  Scripture  Media Arrange Inspector
Tahoma ~ | |Auto v am A~ |[Jv|/B 1 |U élnspedor - n Reset Styles
n - nfo
resentation

A mighty fortress is our Ged, Title A Mighty Fortress Is Our God

A bulwark never failing, X

A bulwark never failing, Slide Author Hans Leo Hassler Martin Luther

Bulwark never failing,

¥ Back d " "

A bulwark never failing, ac g.r.uun Copyright Public Domain @

A bulwark never failing, Transition .

Abulvar never fiing. samivigor [ ]

Element

Qur helper He amid the, Fill

Flood our helper He, Border

Our helper amid the flood,

Of mortal ills prevailing, shadow

Mid mortal ills prevailing, Reflection
EJ=]) Verse 3 Text

For still our ancient foe,

For still our ancient foe, Font |

Doth seek for us woe, Qutline n

Doth seek for us woe,

With craft and great might, v shadow
+ (e Bullets [

Media | 7 Cancel
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Info
Presentation
Slide

Background
Transition
Element
Fill
Border
Shadow
Reflection
Text
Font
Cutline
Shadow
Bullets
Media

N info

Title

Author
Copyright
Adrministrator

Song Mumber

|Chri5tﬁkru:-5e

| Robert Lowry

|F'|_|I::|Iic Domain

Add or edit information for the song's Title, Author, Copyright, Administrator, and Song
Number. The Title field can also be used to view or change the name of a Presentation or

Theme.
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Presentation

Info

Slide

Presentation Attributes

Aspect Ratio Auto W

[]Loop Presentation
Background

Transition Presentation Theme Revert to Global

Element
Fill
Border
Shadow
Reflection

Text
Font
Outline
Shadow
Bullets

Media

1. Aspect Ratio sets the aspect ratio of the presentation.
2. Loop Presentation sets whether or not the presentation will replay when complete.

3. Presentation Theme allows you to revert the changes made to the default theme
settings.
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Slide
info Slide Attributes
Presentation
Theme Elernents (Show/Hide)
Slide Blsong |
Background scripture
1 copyright
Transiticn
Element
Fill
Border
Shadow Advance Slide
Reflection Advance On Click ~
Text 00: 00, 00 =
Font []Loop Slide
Outline Alwa}rs start slide from beginning
Shadow
Bullets
Media

The Slide tab allows you to show/hide Theme Elements on your slide. Check the desired
elements.

Advance Slide:

« Select On Click to manually control the transitions with the mouse or keyboard.
« Select Automatically for an automatic transition.

« Selected Delayed if you want the transition to start after a certain period of time.
After sets the length of time to wait before the transition begins.

Apply to Theme applies the changes made in the Inspector to the theme being used.

Revert to Theme reverts the changes made in the Inspector back to the default theme
settings.
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Info

Presentation

Slide

Background

Transition

Element
Fill
Border
Shadow
Reflection

Text
Font
Outline
Shadow
Bullets

Media

Color Fill

Slide Background
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Fill Style

Mone

Apply to Theme

Revert to Theme

86
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Info

Slide Background

Presentation
Fill Style | Color Fill o

- Color | NN
Background Opacity ' 100 =

Transition

Element
Fill
Border
Shadow
Reflection

Text
Font
Outline
Shadow
Bullets

Media

Apply to Theme Revert to Theme

1. The Color selector lets you choose the background color of the slide.

2. The Opacity slider sets the transparency of the color fill.

Gradient Fill

87
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Info

Slide Background

Presentation
Fill Style | Gradient Fill o

Slide Gradient Properties
Background Style Gradient Style -
Transition Colors _V _v
Element ] Mirrer Colors Angle y
Fill
Border Opacity '

Shadow
Reflection

Text
Font
Outline
Shadow
Bullets

Media

Apply to Theme Revert to Theme

The Style selector provides various gradient styles to select from.
Color 1 sets the color for half of the gradient.

Color 2 sets the color for half of the gradient.

Mirror Colors adds color 1 to each side of color 2.

The Angle dial and field allows you to set a specific angle for the gradient.

o o 0w N =

Opacity sets the transparency of the gradient.

Media Fill
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Slide Background

Presentation

Slide

Fill 5tyle | Media Fill w

Media Properties

Background Select Media | fp_yellow sky hd v

Transiti -
ransHen Media Usage = =
Element
Fill _ o
Aspect Ratio cod | E2d  [C]
Border

Shadow Bpacky '

Reflection

= Mute

Text

Font
Outline
Shadow
Bullets

Media

® N o o bk w

. Select Media allows you to browse and select media that has been added to the

Resource Area of EasyWorship.

Media Usage changes how the background image behaves.
Selecting the Picture icon | stretches the image to fill the screen and loops.

Selecting the Movie icon g does not stretch the video or image and does not loop if
the background is a video.

The Repeating selector determines how a video will behave.

Aspect Ratio sets the aspect ratio of the background.

Opacity sets the transparency of the background media item.

Volume changes the volume of the media item being used as the background.
Mute mutes or unmutes the volume of the media item being used as a background.

Apply to Theme applies the changes made in the Inspector to the theme being
used.
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9. Revert to Theme reverts the changes made in the Inspector back to the default
theme settings.

Transition

Info Slide Transition

Presentation
Transition Reveal Ry

Slide Transition In

Background Duration ' 00.50 =
Easze In ' Ease Qut

Element

Options
Fill .
Direction left =
Bord
oreE Fade Out ]
Shadow
Reflection
Text []Lock background when possible
Font
Outline
Shadow
Bullets
Media
Apply to Therne Revert to Themne

1. The Transition drop-down allows you to select the transition you wish to use for the
slide. Click the | p: button to preview the transition in the media editor.

2. Duration sets the length of the transition from start to finish.

3. Ease In/ Ease Out: Controls whether the transition starts out fast and slows down
or starts out slow and speeds up. If the slider is all the way to the left it will start slow
and end fast. If the slider is all the way to the right it will start the transition fast and
end slow.

4. The Options box present available settings for each transition type. For example,
some transitions have the option to start from different directions on the screen.
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5. Apply to Theme applies the changes made in the Inspector to the theme being
used.

6. Revert to Theme reverts the changes made in the Inspector back to the default
theme settings.

Element

Info Element Attributes

Presentation
[] Constrain Proportions

Slide Opacity § e E
Background

Transition

Fill
Border
Shadow
Reflection

Text
Font
Outline
Shadow
Bullets

Media

1. Constrain Proportions: Locks the aspect ratio of the selected element so that
when it is resized the aspect ratio maintained.

2. Opacity: Controls the transparency of the selected element.

3. Apply to Theme applies the changes made in the Inspector to the theme being
used.

4. Revert to Theme reverts the changes made in the Inspector back to the default
theme settings.
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Fill
This part of the Inspector gives you control over the background of the selected element.

None

Info Element Fill

Presentation
Fill 5tyle | Mone w
Slide

Background

Transition

Element

Border
Shadow
Reflection

Text
Font
Outline
Shadow
Bullets

Media

Apply to Theme Revert to Theme

Color Fill
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Info
Presentation

Slide

Background

Transition

Element
Border
Shadow
Reflection

Text
Font
Outline
Shadow
Bullets

Media

Element Fill
Fill Style | Color Fill w
Color | [NEEEEENN -
Opacity P E
Apply to Theme Revert to Theme

1. The Color selector lets you choose the background color of the slide.

2. The Opacity slider sets the transparency of the color fill.

Gradient Fill

93
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Info

Element Fill
Presentation
Fill Style | Gradient Fill o
Slide Gradient Properties
Background Style Gradient Style -
Trenstion Colors | NN~ | | NN
Element ] Mirrer Colors Angle y
Fill
Border Opacity '
Shadow
Reflection
Text
Font
Cutline
Shadow
Bullets
Media

Apply to Theme Revert to Theme

The Style selector provides various gradient styles to select from.
Color 1 sets the color for half of the gradient.

Color 2 sets the color for half of the gradient.

Mirror Colors adds color 1 to each side of color 2.

The Angle dial and field allows you to set a specific angle for the gradient.

o o 0w N =

Opacity sets the transparency of the gradient.

Media Fill

94
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Info

Element Fill
Presentation
Fill 5tyle | Media Fill w
Slide Media Properties
Background Select Media Mone ~
Transiticn Media Usage .=. ﬁ
Element -
Fill . -~ — —
Sorder Aspect Ratio el Co2 | B2 | (2]
Shadow AT ' 100 :
Reflection
Text - Fute
Font
Cutline
Shadow
Bullets
Media
Apply to Theme Revert to Theme
1. Select Media allows you to browse and select media that has been added to the
Resource Area of EasyWorship.
2. The Media Usage selector stretches the image or video to fit the screen and if the
background is a video, it loops.
3. The Repeating selector determines how a video will behave.
4. Aspect Ratio sets the aspect ratio of the background.
5. Opacity sets the transparency of the background media item.
6. Volume changes the volume of the media item being used as the background.
7. Mute mutes or unmutes the volume of the media item being used as a background.

95

-95.-



EasyWorship 6 User Guide 96
General Topics

Border

Info Element Border

Presentation

Border Style Line w
Slide Advanced
Background Color _V
Transiti
ransten loin Round w
Element Position Inner w
Fill =
Size ' 4 -
Shadow AT ' 100 =
Reflection
Text
Font
Cutline
Shadow
Bullets
Media
Apply to Theme Revert to Theme

This part of the Inspector provides the option to turn on borders for the selected element,
change border formatting, and adjust border placement on the edge of the element.

1. Border Style allows you to choose the type of border for the element.
o None turns element border on or off.
o Outer places the border on the outside edge of the element.
o Center places the border on the center of the edge of the element.
o Inner places the border on the inside edge of the element.
2. Color sets the color of the border.

3. Join allows you to choose between Round, Bevel, and Miter joins. This influences
the joins in a border such as a corner.

4. Position allows you to choose Outer, Center and Inner for the location of the border
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on the edge of the element.
5. Size sets the thickness of the element border.
6. Opacity sets the transparency of the element border.

7. Apply to Theme applies the changes made in the Inspector to the theme being
used.

8. Revert to Theme reverts the changes made in the Inspector back to the default
theme settings.

Shadow

Info Element Shadow

Presentation

Shadow Style Enabled w
Slide Advanced
Background Color _V
Transiticn Angle 315 .
Element -
Offset y 10 -
Fill -
E!I ; Blur ' 5 S
araer
BT O 7
Reflection
Text
Font
Cutline
Shadow
Bullets
Media
Apply to Theme Revert to Theme
1. Shadow Style selects the pre-designed type of shadow to be used.
2. Color changes the color of the shadow.
3. Angle sets the angle of the element shadow.
4. Offset controls the distance of the shadow from the element.
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5. Blur allows you to blur the element shadow.
6. Opacity sets transparency of the element shadow.

7. Apply to Theme applies the changes made in the Inspector to the theme being
used.

8. Revert to Theme reverts the changes made in the Inspector back to the default
theme settings.

Reflection

Infa Element Reflection

Presentation

<

Reflection Style Enabled

Slide Advanced
Background Cize ' A0 =
Transition Distance '
Element Opacity '
Fill
Border
Shadow
Text
Font
Cutline
Shadow
Bullets
Media
Apply to Themne Revert to Theme
1. Reflection Style sets the pre-designed style of reflection for the element.
2. Size modifies the size of the reflection.
3. Distance changes the distance between the element and its reflection.
4. Opacity controls the transparency of the element reflection.
5. Apply to Theme applies the changes made in the Inspector to the theme being
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99

theme settings.
Text
ke Text Attributes
Presentation Margins
; Left 13 - Top 7 .
Slide
i 13 = 7 =
Background S Bottom
Transition Text Layout
Element Vertical Align Center w
Fill
I Auto Sizing
Border
() Do not auto size text
Shadow _ .
Rl (®) Resize text to fit element
___, [+] Mormalize test size across slides
Text
Eont Formatting
Outline [ Word Wrapping
Shadow [ Capitalize all words
Bullets [] Capitalize first word of each line
Media

1. Margins: Left, Right, Top, and Bottom margin settings

2. Vertical Align allows you to change the vertical alignment of the text.

3. Auto Sizing:

m Do not auto size text turns auto-sizing off.

m Resize text to fit element turns auto-sizing on. Check the Normalize text size
across slides box if you want EasyWorship to automatically make text on all

slides the same size.
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4. Formatting
m  Word wrapping turns automatic word wrapping on/off.
m Capitalize all words automatically makes all words appear in all caps.

m Capitalize first word of each line automatically capitalizes the first character of

each line.
Font
Inspector - n
Info Text Font
Presentation Font
Font Mame Tahorma ~

Slide

Background size Auto -

Transiticn Color I:lv
Element s — -

Fill []Underline  []Superscript [ ] Subscript

Border Opacity ' 100 =

Shadow

Reflection b

Text Alignment Center w

Text

Cutline

Shadow

Bullets
Media

Reset Styles

1. Font Name allows you to select a font style from the drop-down.
2. Size sets the font point size.
3. Color changes the color of the text.
4. Style allows you to select Regular, Bold, Italic or Bold Italic.
5. Underline turns underline on or off.
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6. Superscript turns superscript on or off.
7. Subscript turns Subscript on or off.
8. Opacity sets transparency of the text.
9. Alignment allows you to set the horizontal alignment of the text.
Outline
Inspector - n
Info Text Outline
Presentation QOutline
Syl Out w
Slide e S
Background Coler I
Transition Join Round w7
Element Size ' ! =
Fill Opacity Ploo B
Border
Shadow
Reflection
Teaxt
Font

Shadow
Bullets

Media

1. The Style drop-down allows you to choose None, Outer, Center, and Inner for the

Reset Styles

5. Opacity sets transparency of the text outline.

location of the outline on the edge of the text.

Color changes the color of the text outline.

Size sets the thickness of the text outline.

Join allows you to choose between Round, Bevel, and Miter joins. This influences
the joins in an outline such as a corner.

101
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Shadow
Inspector - n
Info Text Shadow
Presentation Shadow
Shde Style Enabled ~
Background Coler I
Transition Angle
Element Offset ' 16 -
Opacy N
Shadow
Reflection
Teaxt
Font
Cutline
Bullets
Media
Reset Styles
1. Style turns text shadow on or off.
2. Color changes the color of the text shadow.
3. Angle sets the angle of the text shadow.
4. Offset controls the distance of the shadow from the text.
5. Blur allows you to blur the text shadow.
6. Opacity sets transparency of the text shadow.

-102-



EasyWorship 6 User Guide 103
General Topics

Bullets

Inspector - n

Info Text Bullets

Presentation
Indent Level S

Background Bullet Style | Bullets ~

Transition
Bullet .

Fill

Border
Shadow
Reflection

Text
Font
Outline
Shadow

Media

Reset Styles

1. Indent Level sets the indent for bullets.

2. Bullets selects between Bullets or Numbers, and reveals options for selecting the
bullet or number style.

Media

This section is grayed out unless a media element is selected in the editor.
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Inspector - n

Info Media Attributes

Presentation

Mame |95A Psalm Of Praise |

Slide Media Properties
Background Media Usage e -
Transiticn Repeating ALTO o -
Element Aspect Ratio el Cod | Ecd | (2]
Fill =
' Opacity '
Border
Shadow Audio Properties
Reflection ETE ' [IMute
Text
Font
Outline
Shadow
Bullets

1. Name: The name of the media element selected.

2. Media Usage changes how the background image behaves.
m Selecting the Picture icon i | stretches the image to fill the screen and loops.

= Selecting the Movie icon g does not stretch the video or image and does not loop
if the background is a video.

Aspect Ratio sets the aspect ratio of the background.

Opacity sets the transparency of the background media item.

Volume changes the volume of the media item being used as the background.

o gk~ w

Mute: Mutes or unmutes the volume of the media item being used as a background.
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Options

To access the Options menu in EasyWorship, click Edit > Options.... In the bottom left
corner of the Options window, there is a checkbox next to Preview Output. Use this option
to view changes on the output screen as you make them.

Live
[I# Options O et
— Live Options
i Select Output Monitor
Scripture o Mon |'M e F 7 | r Output Position ——
tput t t P
Presentation utput Manitor  |iMonitor 1 (Secondary) Lot 00 |:
Alerts Alpha Channel | Disabled v -
Top |22 &
Foldback Width (3200 |3
Song Height [1800 [%
Scripture
Alerts and Clocks
Transitions Screen Margins
Service Intervals Left 0 l: Top 0 l:
Advanced Right |0 [ Bettom 0 |5
Default Font

Default Font Default Font ~

song text line one
song text line two

somg text line three
song text line four

[[] Preview Output oK | ‘ Cancel

Select Output Monitor

This is where you can setup how and where EasyWorship sends its output to the audience.

This drop-down button allows you to set the screen or location where

Output Monitor . you wish to send the EasyWorship output.
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Output Position

Alpha Channel

Monitor Setup

Screen Margins
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Allows you to select the format you wish to send to the NewTek
TriCaster over your local network connection. This option is only
available when selecting the NewTek AirSend option from the
Output Monitor drop-down.

Shows you where EasyWorship is sending its output to by pixel loc-
ation. If custom position is select from the Output Monitor drop down,
you will enter the location you want EasyWorship to send its output to
in these fields.

This drop-down button allows you to select which output to send
alpha channel content to. This option is not available if you have selec-
ted the NewTek AirSend output from the Output Monitor drop-down.

Opens the Windows Display Settings window to allow you to extend
your windows Desktop to another screen or change other display set-
tings without having to close EasyWorship.

This section allows you to customize the screen margins, i.e., fine-tuning the placement of
EasyWorship content on the output screen.

Default Font

When you click the Default Font drop-down, the following window appears, allowing you
to set the default appearance of the text.
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¥ AND LOod =314, LET TNE WaTEers U =i
FONT | OUTLINE | SHADOW | MARGINS | FORMAT ne
B+ Options
Font
L . .
Live Options Fort Nome [Tahoma .
Seng =
. Select Output Monit Size 73 B
Scripture Outout Mot
Presentation tput Montar Color [ 1w~
Alerts Alpha Channel Style Bold "
Foldback (JUnderline  []Superscript [ Subscript
Song Opacity '
Scripture .
Miscellaneous Alignment
Text Alignment | Center ~
Transitions Screen Margins . ) .
Vertical Align Center ~
— et [0 ]
Vance
Righ ;
.5 Reszet
y Default Font
song text line one
song text line two Default Font Default Font
song text line
three
song text b
line fowur, B
[ Preview Output oK Cancel bh fwere
This tab allows you to select a default font style and size, change the
color and style of the text, turn Superscript and Subscript on/off, set
Font Tab . .
the opacity (transparency) of the text, and set the horizontal and ver-
tical alignment of the text.
This tab allows you to turn text outline on/off, change the color of the
text outline, choose between Round, Bevel, or Miter joins (influences
Outline Tab joins in an outline, such as a corner), choose the location of the outline
on the edge of the text (Outer, Center, or Inner), and set the thickness
and opacity (transparency) of the text outline.
This tab allows you to turn text shadow on/off, change the color, angle,
Shadow Tab and offset (distance) of the text shadow, and set the blur and opacity
(transparency) for the text shadow.
. This tab allows you to set the Left, Right, Top, and Bottom margin set-
Margins Tab .
tings.
Format Tab This tab allows you to customize song text formatting.
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« Auto Sizing - select "Do not auto size text" if you want to turn
auto sizing off, or select "Resize text to fit element" to turn auto
sizing on (check the box next to "Normalize text size across
slides" if you want EasyWorship to automatically make text on
all slides the same size).

o Word Wrapping - check this box to turn automatic word
wrapping on.

« Capitalize all words - check this box to automatically make all
words appear in call caps.

o Capitalize first word of each line - check this box to
automatically capitalize the first word of each line in a song.

« Automatically capitalize the first character of these words -
check this box to automatically capitalize the first character of
the words listed below when they are used in a title slide.

Song

This part of the Options menu allows you to change the default settings for songs, i.e., the
look and feel of song text and margins being displayed to your audience.
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¢ Optiens O x
Live Live - Song Attributes
e
Scripture o " Song Font +
Presentation -
Alerts [] Show Verse/Chorus Label Label Font -
Labels for Importing and Celor Coding Labels =
Foldback
Song Copyright Info
Scripture [] Display Copyright Information | Copyright Font =
Miscellanecus License Info |
Transitions
Adwvanced
12,5
song text line one
song text line two
song text line three
song text line four
[ Preview Qutput 0K Cancel
Refer to "Default Font" on page 106 for information on the
Song Font S
options in this window.
Checking this box tells EasyWorship to display labels that
Show Verse/ g y P Pay

Chorus Label

Label Font

Labels for Importing
and Color Coding

Display Copyright
Information

Copyright Font

have been entered into your song, e.g., Verse, Chorus,
Bridge, etc.

Refer to "Default Font" on page 106 for information on the
options in the Label Font window.

This option allows you to set the color coding of your choice
for labels and set custom shortcut keys for each type of label.
You can also add new labels if the desired label does not
exist.

Checking this box tells EasyWorship to display Copyright info
on song slides when displaying to the audience.

Refer to "Default Font" on page 106 for information on the
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Scripture
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options in the Copyright Font window.

The License Info field allows you to enter your CCLI or other

copyright license number to be displayed on songs that

require copyright information to be displayed.

This part of the Options menu allows you to enable/disable support for displaying
scriptures (turns EasyWorship's Scripture tab on/off) and customize the default settings for

scriptures, i.e., the look and feel of scripture text and margins being displayed to your

audience.
[ Options O
Live - . .
Live - Scripture Attributes
SEE Enable Scripture Support
Scripture ; s
- [/l:Enable support for displaying scriptures:
Presentation
Scripture Layout
Alerts
Foldback
° c Show verse numbers
Song
Scriot Show Reference
cripture
Alerts and Clocks Reference Location | After Each Slide ¥ ‘
Transitions [] Show Complete Passage
Service Intervals Reference Indent
[] Abbreviate Book Mames
Advanced
[] Additional Line Spacin
p g
[] Show Reference Only (Hide Scripture Text)
153 ] Break on new verse
*In the beginning God cre_latf.-d
tﬁlz':f::i:;”&;:iIf;::"]::ﬁﬂ Automatically Flow Scripture on Multiple Slides
id; and darki ’ h - . . - -
f:Ee c.fa:he de;:fii.;::eu;;;:i: ;.? Minimum font size before breaking slide m
God moved upon the face of the
AL
[] Preview Qutput | oK ‘ | Cancel
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Enable support for
displaying scriptures

Scripture Font

Show verse numbers

Verse Font

Show Reference

Reference Font

Reference Location

Show Complete Passage

Reference Indent

Abbreviate Book Names

Additional Line Spacing

Show Reference Only
(Hide Scripture Text)

Break on a new verse

Automatically Flow Scrip-
ture on Multiple Slides

Minimum font size|
before breaking slide
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Checking this box tells EasyWorship to enable support for
displaying scriptures (turns EasyWorship's Scripture tab
on).

Refer to "Default Font" on page 106 for information on the
options in the Scripture Font window.

Checking this box tells EasyWorship to enable verse num-
bering in the scripture text.

Refer to "Default Font" on page 106 for information on the
options in the Verse Font window.

Checking this box tells EasyWorship to show the scrip-
ture reference on the output screen.

Refer to "Default Font" on page 106 for information on the
options in the Reference Font window.

Allows you to place the scripture reference Before Each
Slide, After Each Slide or After Each Passage

When this box is checked, the complete scripture pas-
sage reference will be visible on every slide instead of
showing the reference for only the passages on the cur-
rent slide being displayed.

When this box is checked, EasyWorship indents the scrip-
ture reference.

When this box is checked, EasyWorship will abbreviate
the book name in the scripture reference.

When this box is checked, EasyWorship will add addi-
tional line spacing between the scripture and the ref-
erence.

When this box is checked, EasyWorship will hide the text
of the verses in the slide. The reference will use the ref-
erence font settings. If the slide is in edit mode, this setting
is ignored.

When this box is checked, this option tells EasyWorship
to create a new slide for every verse.

When this box is checked, EasyWorship will automatically
insert slide breaks for each chapter. Unchecking this
option will allow you to override the default breaks.

This option allows you to set a limit on how small the text
in a scripture slide can appear before creating a new
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slide.

Presentation

This section of the Options menu allows you to customize the default fonts for the Title,
Subtitle, and Content slides in your Presentations, i.e., the default look and feel for fonts in
the slides you create under the Presentations tab.

[ Options O >
Live Live - Presentation
Song Presentation Layout
Scripture i
Alerts SubTitle Font SubTitle Font «
Content Font Content Font =
Foldback ot ren
Song
Scripture

Alerts and Clocks

Transitions

Service Intervals

Advanced

12,5

title style

thesmyle

# content style
» level 2
» level 3
# level 4
= level 5
= level &
* level 7
# level 8

[ Preview Qutput QK Cancel
P

Refer to "Default Font" on page 106 for information on the options in the

Title Font Title Font window.

Refer to "Default Font" on page 106for information on the options in the

SR A SubTitle Font window.

Refer to "Default Font" on page 106 for information on the options in the

EoRteont Content Font window.
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Alerts

The Alerts tab allows you to set options for the alerts that appear on screen.

[ Options I} O .
Live Live - Alert Options
song MNursery Alert Options
Scripture
. [+] Enable Mursery Alert Mursery Font -
Presentation
Background Qpacity '
Foldback
Song Screen Location Top Right ~
Scripture [+] Automatically Remove
Alerts and Clocks After | 01:00 -
Transitions Message Alert Options
Service Intervals [ Enable Message Alert | Message Font
Advanced Background Color _v
Background Qpacity '
Screen Location Bottom ~
e e e Scroll Speed y
song text line thnee
=ong text line four
[ Preview Qutput oK Cancel
Nursery Alert Options
Enable Nursery Alert Check to allow nursery alerts.

Click to set the default font settings for the nursery
Nursery Font alerts. Refer to "Default Font" on page 106 for inform-
ation on the options in the Nursery Font window.

Background Color Sets the background color of the nursery alert.
Background Opacity Sets the background opacity of the nursery alert.

Allows you to set the position of the nursery alert on the
screen.

Screen Location
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To automatically remove the alert after a set amount of

Automatically Remove After time, click the checkbox and enter the desired time

Message Alert Options

Enable Message Alert

Message Font

Background Color
Background Opacity
Screen Location

Scroll Speed

limit.

Check to allow message alerts.

Click to set the default font settings for the message alerts.
Refer to "Default Font" on page 106 for information on the
options in the Message Font window.

Sets the background color of the alert.
Sets the background opacity of the alert.
Allows you to set the position of the alert on the screen.

Sets the speed at which the messages are scrolled through.
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Foldback
B Options | x
p
Live Foldback Options
S Enalble Display Foldhack
Scripture

Enable support for display Foldback (stage display)
Presentation

Select Output Monitor
Alerts

Output Monitor  |{Monitor 1 (Secondary] | ~ | [ Custom Position —

Song Top -232 l%
Scripture —
i Width (3200 |5
Alerts and Clocks
Height 1800 [5
Transitions
Service Intervals Default Font

Advanced Default Font Default Font ~

Mext Item Information

Enable next itern info | Mext ltem Font ~

Background Color |

Screen Margins
Left o |5 Tep |0
sang text line ane Right ] l% Bottom |0

sang text line two

|4y

song text line three
song text line four

[] Preview Output OK | ‘ Cancel
E-n ke BROHUCCH Checking this box allows EasyWorship to take advantage of a
display Foldback o . .

. third video output to display content for stage monitors.
(stage display)

This drop-down allows you to set the screen or location to which

SR LI the EasyWorship output foldback content will be sent.

These fields show you where EasyWorship is sending its foldback
content to by pixel location. If custom position is selected from the
Output Monitor drop down, this is where you will enter the location
you want EasyWorship to send its output to.

Custom Position
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This menu allows you to set the default appearance of the text.
Default Font Refer to "Default Font" on page 106 for information on the options
in this window.

Checking this box enables Next Item Information. Next item info

SRl can show up either 1) as the first line of the next slide, or 2) as the

T title of the next item in the schedule.
This menu allows you to set the appearance of the text. Refer to
Next Item Font "Default Font" on page 106 for information on the options in this

window.
Background Color Sets the background color for the next item.

These fields allow you to fine-tune the Left, Right, Top, and Bot-
Screen Margins tom screen margins so EasyWorship's content displays properly
on the foldback screen.

Song

The Song Attributes window allows you to change the default settings for songs, i.e., the
look and feel of song text and margins being displayed to your audience.
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[ Options - ~
Live Foldback - Song Attributes

>ong Song Layout

Scripture

] Song Font Song Font -
Presentation

Alerts [] Show Verse/Chorus Label =

Foldback

Scripture

Alerts and Clocks

Transitions

Service Intervals

Advanced

song text line one
song test line two

song text line three
song text Fne four

[] Preview Qutput oK Cancel
P

Refer to "Default Font" on page 106 for information on the options in

S T this window.

Show Verse Checking this box tells EasyWorship to display labels that have been
IChorus Label enteredinto your song, e.g., Verse, Chorus, Bridge, etc.

Label Font R.efer.to Default Font" on page 106 for information on the options in
this window.

Scripture

The Scripture Attributes window allows you to enable/disable support for displaying
scriptures (turns EasyWorship's Scripture tab on/off) and customize the default settings for

scriptures, i.e., the look and feel of scripture text and margins being displayed to your
audience.
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[ Options O et
Live . .
Foldback - Scripture Attributes
S Enable Scripture Support
Scripture ; ;
i [iEnable support for displaying scripturesi
Presentation
Scripture Layout
Alerts
Foldback
° ¢ ] Show verse numbers »
Song
s Show Reference
Alerts and Clocks Reference Location | After Each Slide o |
Tiariices Reference Indent
Service Intervals [] Additional Line Spacing
Advanced [] Show Reference Only (Hide Scripture Text)
10:28
LIn the beginning God created the
heaven and the earth. ? And the earth
wias without form , and void ; and
darkness was upon the face of the
deep. And the Spirit of God moved
uponth-cfa:ti:u-f It;l:c.:\\::t:r:
[] Preview Output OK | ‘ Cancel

Enable support for
displaying scriptures

Scripture Font

Show verse numbers

Verse Font

Show Reference

Checking this box tells EasyWorship to enable support for
displaying scriptures (turns EasyWorship's Scripture tab
on).

Refer to "Default Font" on page 106for information on the
options in the Scripture Font window.

Checking this box tells EasyWorship to enable verse num-
bering in the scripture text.

Refer to "Default Font" on page 106 for information on the
options in the Verse Font window.

Checking this box tells EasyWorship to show the scripture
reference on the output screen.
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Reference Location

Reference Indent

Additional Line Spacing

Show Reference Only
(Hide Scripture Text)

Alerts and clocks
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Refer to "Default Font" on page 106 for information on the
options in the Reference Font window.

Allows you to place the scripture reference Before Each
Slide, After Each Slide or After Each Passage

When this box is checked, EasyWorship indents the scrip-
ture reference.

When this box is checked, EasyWorship will add additional
line spacing between the scripture and the reference.

When this box is checked, EasyWorship will hide the text
of the verses in the slide. The reference will use the ref-
erence font settings. If the slide is in edit mode, this setting
is ignored.

The Alerts and Clocks tab allows you to enable/disable and customize Clock options,
Service Interval options, and Message Alert options.
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[ Options H x
Live Foldback - Alert and Clock Options
ong Clock Options
Scripture

. [+] Enable Foldback Cleck Clock Font -
Presentation

Alerts Background Celer I -
Foldback Screen Location Top Right w
Song Format hh:nn v
Scripture Service Interval Options
[]Enable Sevice Interval -
Transitions

Service Intervals

Advanced
Allow Owerrun
Message Alert Options
[] Enable Message Alert Message Font =

Background Color I
song text line one . -
song test fine two Background Opacity '
song text line three
S

song text e four

Screen Location Bottom

s sanye ot S Scroll Speed '

[ Preview Qutput oK

Cancel
Clock Options

Enable Foldback Clock Checking this box enables the Clock Options.

Clock Font Refer tq "Default Font" on page 106 for information on the

options in the Clock Font window.

Background Color Sets the background color of the clock.

Screen Location Sets the position of the clock on the screen.

Format Sets the desired format of the time on the clock.

Service Interval Options

Enable Service Interval Checking this box enables service intervals.
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Refer to "Default Font" on page 106 for information on the

el options in the Font window.

Background Color Sets the background color of the service interval.

Screen Location Sets the position of the service interval on the screen.
Format Sets the desired format of the time on the service interval.

Allow Overrun

Message Alert Options
Enable Message Alert  Check to allow message alerts.

Click to set the default font settings for the message alerts.
Message Font Refer to "Default Font" on page 106 for information on the
options in the Message Font window.

Background Color Sets the background color of the alert.

Background Opacity Sets the background opacity of the alert.

Screen Location Allows you to set the position of the alert on the screen.
Scroll Speed Sets the speed at which the messages are scrolled through.
Transitions

This section allows you to determine the default styles for slide to slide transitions, as well as
Black, Clear, and Logo transitions (Black, Clear, and Logo buttons are on the right side of
EasyWorship's main toolbar).
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[ Optiens O x
Live ..
Transitions
Song Transition Options
Scripture
. Slide Transition Blend -
Presentation
Alerts Black Transition slide Transition
iti Transition In
Foldback Clear Transition
Song Logo Transition Transition | Blend il -
Scripture Duration ' M. =
Alerts and Clocks Ease In ' Easze Out
Service Intervals
Advanced
[ Lock background when possible
Lond You are beauwtiful,
I raize ny hands to You,
Mo one else can touch
my heart like You dao,
[ Preview Qutput oK Cancel

Slide Transition - The type of transition to use between schedule items, and between

items in a song, scripture, or presentation.

Black Transition - The type of transition to use between black and non-black displays.

Clear Transition - The type of transition to use between clear and non-clear displays.

Logo Transition - The type of transition to use between logo and non-logo displays.

The following instructions apply to all four fields:

1. Transition - Use the drop-down list to select the desired transition.

2. Duration - Set how long the transition should be.

Ease In / Ease Out - Use the slider to set the Ease In/ Out. Ease In will cause the

transition to start out slowly and then quickly speed up at the end. Ease Out will cause
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the transition to start out quickly and then slow down at the end.

4. Options - Based on the Transition chosen, various options will appear.

Service Intervals

¢ Options O d
p
Live Service Intervals
S Service 5tart and Stop Times
Scripture

Day Start Tirme Stop Time
1~] [oo:00:00 B [10:00:00

Presentation

Alerts

Foldback
Song
Scripture

Alerts and Clocks

Transitions

Service Intervals

Advanced

Add

zong text line one
=ong text line two

song text line three
song text line four

[] Preview Output QK Cancel
[

Service intervals allow you to set up a start and end time for your services. Click Add to
create one or more service intervals.
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Advanced
[ Options O >
Live Advanced
song Live Options
Scripture
O Show live screen on startup
Presentation
Advance Schedule after Go Live is pressed
Alerts
PowerPoint Options
Foldback o . . o
O Use the PowerPoint Viewer instead of the Full PowerPoint Application
Song
Scripture DVD Options
Alerts and Clocks Use preferred DVD video codecs
O Prevent DVD spin down
Transitions
Video Card Options
Service Intervals
O Disable GPU Shrink Filter
Advanced Font Setings
Edit Font Fallback List Edit Compatibility Fonts List
Schedule File Options
song text line one Pack files in new schedule by default (recommended)
song text line two
song textlline three
song text line four,
O Preview Output oK Cancel

Live Options

Show live screen on
startup

Advance Schedule after
Go Live is pressed

When checked, this options tells EasyWorship to display
the last used background on the output screen imme-
diately after the program has launched.

When this box is checked, EasyWorship automatically
selects the next item in the schedule when Go Live is
clicked. For example, the first item in your schedule is a
mini-movie and the second item is a song. When you

select the first item and click Go Live, the mini-movie plays
and the song is automatically selected and ready to go live
as soon as the mini-movie ends. All you need to do is click
Go Live again to send the song to the audience.
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PowerPoint Options

When this box is checked, EasyWorship will
load the PowerPoint Viewer to display
PowerPoint slide shows.
Use PowerPoint Viewer instead of
Full PowerPoint Application WARNING! The PowerPoint Vieweris an
unsupported feature and may result in
empty PowerPoint thumbnails with some
video cards.

DVD Options

When this box is checked, EasyWorship will look
for and use DScaler if it is available (EasyWorship
ignores other decoders if the DScaler codec is
available).

Use preferred DVD video codecs

When checked, this keeps the DVD in the drive
Prevent DVD spin down spinning at all times to reduce the amount of time
needed to send a DVD clip to the screen.

Video Card Options

Only select this if you are only seeing a solid color on the out-
Disable GPU Shrink Filter putscreen. This option should only be used to troubleshoot
rendering issues with your video card.

Advanced Font Settings

When EasyWorship encounters a character which is not
part of the designated font, a fallback font is used

instead. Typically, a fallback font will contain symbols rep-
resentative of the various types of Unicode characters.

Edit Font Fallback List

If you are using non-Latin fonts that do not support
Unicode, add them to this list to force them to appear in
the Schedule and Words Editor.

Edit Compatibility Fonts
List

Schedule File Options

Pack Files in new schedule To runthe Schedule from the same computer, you can
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uncheck the option to Pack files in schedule box. This
by default (recommended) will save space on your computer. If you'll be transferring
the schedule to another computer, uncheck this box.
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PowerPoint Integration

Importing a PowerPoint Presentation into EasyWorship

There are two ways to import a PowerPoint presentation into EasyWorship - directly into the
Schedule or within the Presentations tab.

Adding a Presentation to the Schedule

1. Click the Settings icon in the Schedule Area. Select Add Item... > Browse for
PowerPoint file....

B EasyWorship - Your Church - Default
File Edit Live Profiles View Help

o (. & &

New Open Web
Schedule jj‘ ¥ |k~ | Live
Import Schedule File... Add Item >
New Blank Presentation... Edit Item.
Edit Note...

Browse For Presentation File...

Browse For PowerPoint File... Move Item Up

Browse For Media File... Move Item Down

Remove from Schedule

Expand All ltems

Collapse All Items

View >

2. Navigate to and select the desired PowerPoint presentation and click Open.

Adding a Presentation to the Presentations Tab

1. Click the Presentations tab in the Resource Area.

2. Click the Settings icon and select Import PowerPoint file....
OR right-click anywhere in the Presentations Area and select Import PowerPoint

file....

-127 -



EasyWorship 6 User Guide 128
General Topics

3. Navigate to and select the desired PowerPoint presentation and click Open.

4. To editthat file, right-click the file in the Presentations Area and select Edit Present-
ation.... It will open up in the PowerPoint application.

5. Toadd the presentation to the Schedule, drag-and-drop it from the Presentations
Areato the Schedule Area.

Jumping In and Out of a PowerPoint Presentation

1. While displaying an imported PowerPoint presentation in EasyWorship, click the
Scriptures tab in the Resource Area.

2. Select the desired scripture and press Enter or click Go Live. The scripture is imme-
diately projected to the live output. A Go Back button appears at the top of the Live

[ EasyWorship - Your Church - Default
File Edit Live Profils View Help
[
Lo @- & &
New Open  Save Web
Schedule - UNTITLED 22 +| @~ | Preview - AHeart Like Thine g;;vCGD_aafD Live - A Heart Like Thine
g ExsyWorship 65 1 6 [ .
e C Jesus, Come to my esus.
- Hear me, O 5:
Openthe fou

3. Click Go Back. The PowerPoint presentation displays to the live output at the same
place you exited to project the scripture.
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Presentations

EasyWorship's robust Presentation Editor is a full slide designer. Choose from different
types of slides, control transitions, create slide loops, and create/apply custom themes.

When you edit a presentation in a Schedule, you can choose to make changes that affect the
presentation for that schedule only, or you can make permanent changes to a presentation in
the Resource Area under the Presentations tab.

mht-CIick Features

When right-clicking a thumbnail in the Presentations tab in the Resource Library, you
have the following options.

Mew Presentation...

Edit Presentation...

Import Presentation File...
Impeort PowerPoint File...

Export Presentation File...
Set As Logo Background -

Delete

| .

Title View 5

Sort by »
Refresh

1. New Presentation...: This will open a new "Presentation Editor" on the next page.

2. Edit Presentation...: This will open the selected theme in the "Presentation Editor" on
the next page.

3. Import Presentation File...: Opens a file selection window to choose an existing
presentation to import.

4. Import PowerPoint File...: Opens a file selection window to choose an existing Power-
Point file to import.

-129-



EasyWorship 6 User Guide 130
General Topics

5. Export Presentation File...: Allows you to export the presentation for use on another
computer.

6. Setas Logo Background: This sets the presentation as the default background logo.
Logos can have multiples slides with animation and timing.

7. Delete: Deletes the presentation from the Resource Library.
View: allows you to change icon size for a custom thumbnail view.
9. Sort by: the same as in Windows.

10. Refresh: This will refresh the thumbnail for the selected item.

Presentation Editor

1. Enter a name for your presentation in the Title field.

2. Onthe left side of the window, there are two tabs - Words and Slides. On the right
side of the window is the Slide Editor. An EasyWorship presentation has five different
slide types to choose from, called Themes. When you start a new presentation, the
first slide will default to a Title slide theme. In the Words tab, you can type in the title
and subtitle you wish you to use.

B> Presentation Editor - Untitled O X

| @&, T B =. - @

a8
L@~ =y ?7 Theme Text Scripture  Media Arrange Inspector

= Reset Styles
v Title

Title & Content

[l
It
b}

Tahoma ~ | | Aute

Words  Slides

15
S  subtitle
C

More Themes

Content Only

Blank

+ 2% L

oK Cancel

3. Clickthe +icon to add a new slide to the presentation. The default theme of the
second slide will be a Title & Content theme. Enter the desired text in the Words
tab. To change the Theme of the slide, use the Theme drop-down to select a new
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Theme.

4. You can add additional content to the slide using the Text button in the toolbar. A new
text box will appear on the slide. The text from the additional text box will not appear
in the Words tab.

5. Toadd anew Scripture slide, click the + icon to add a slide to the presentation.
Then, click the Theme drop-down box and select Scripture. Double-click the slide to
open the scripture lookup. Choose the translation you want and search for the
desired scripture. Double-click the desired scripture to add it to the new slide.

6. To change the background, click the Slides tab. To use the same background for all
slides, click Master Theme at the bottom of the Slides tab and select the master
slide, which will be the first slide. Use the "Background" on page 86 tab in the
Inspector to change the background. To use a different background, click Media and
drag-and-drop the image or video to the desired slide. When you're finished, click
Master Theme.

B Presentation Editor - Untitled O X

| @ T B =. - O

L a8
Q- = Q? Theme Text Scripture Media Arrange Inspector

Tahoma ~ | Auto ¥ ~ B I U S O =

[l
il
il
7l

Reset Styles

Words  Slides
'

Title - Slide

Title

Title - Slide

& < S\ > 2% § L

oK Cancel

Edit a Presentation in the Schedule

In the Schedule Area, select the presentation to be edited.
Right-click the presentation.
Click Edit Item....

The Schedule Editor window appears.

o M N~

The Words tab or Slides tab can be used to enter or edit text as needed.
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6. Use the toolbar to change the font and edit its style, size, and alignment.

7. Use the heading buttons to select a Theme, create a new Text box, add a Scripture,
Media element, or Background, or Arrange Elements.

8. Use the Inspector to customize your presentation.

Edit a Presentation in the Database

In the Resource Area, click the Presentations tab.

Select the presentation you wish to edit.

Right-click the presentation.

Click Edit Presentation.... The Presentation Editor appears.

The Words tab or Slides tab can be used to enter or edit text as needed.

Use the toolbar to change the font and edit its style, size, and alignment.

N oS ok~ w N =

Use the heading buttons to select a Theme, create a new Text box, add a Scripture
or Media element or Background, or Arrange Elements.

8. Use the Inspector to customize your presentation.

Toolbar
‘Exodu: 211 (KIV) | = . B .
[1hd A L'lr_;—;ﬂe T£ Scri@ure Eia ng 1
[Tehoma Jlawe oA [OYEr v [E0]l = =E] === |
. Enter a name for the song, scripture, theme, or present-
Title B
ation in this field.
Theme Use the drop-down to select a theme. (This option is
grayed out in the Theme Editor.)
Text Adds a text box to display on each slide.
Scripture Click the scripture button to select scripture text and press
P enter or drag it to add it to the theme.
Click the media button to select videos, images, feeds,
Media DVD clips, or audio and press enter or drag it to add it to

the theme.

Clicking this button allows you to set the layer at which the
Arrange selected element resides. You have the option of Move
Up, Move Down, Bring to Front, Send to Back.
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Opens the Inspector window. This allows you to make

LRl more detailed formatting changes to different elements.

Allows you to import a text document into your song,

Import presentation, or theme.

Allows you to print the song, schedule, theme, or present-

Print )
ation.

Checks spelling and allows you to make spelling changes
or add words to the dictionary. To add a language to the
spell check dictionary, click the Spell Check button and
select Spelling Options....

| N . |
i - AB -

Spell Check L ¥ Theme | Text S
Tahoma Check Spelling v| a7 a- [

Words  Slide Spelling Options...

1. The Spelling Options window will
appear. Select the Language tab.
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Spelling Opticns
Speling Language  Custom Dictionary

Language zettings
Chooze the language dictionamy to uze when checking spe

E nglizh e

Additional dictionariez

Choose any additional dictionaries to use when checking =

autoconect. adu custom dictionany
[ ] custom.dic Microgoft Office custom

Locate Dictionaries...

Learn About Maki

Crorliog

[«

2. Click Download Additional Dic-
tionaries. The Additional Dictionaries
page will load.

3. Download the dictionary you wish to
add to EasyWorship.

4. Browse to the file you downloaded
and extract it.

5. Inthe Spelling Options window, click
Locate Dictionaries....

6. Browse to the folder you extracted,
select it, and click OK. The new
dictionary will now be available in the
drop-down list under Language
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settings.

Click the font selector to select the font formatting you
wish to use on selected text.

Allows you to choose between setting an exact font size
or automatically sizing the font.

Changes the font size of the text to the point size selected.

Allows you to change the color of selected text by select-
ing from the color palette provided.

Bold, Italics, Underline, Shadow, Outline

Left Align, Center Align, Right Align

Top Align, Middle Align, Bottom Align

Increase or decrease the indent level of the paragraph.

Resets formatting to default settings.

v Insert

Apply changes to items in schedule

Check this box to apply all of the edits made in the Editor
to that item in the currently-open schedule.
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136

In this article, you'll learn how to add, edit, and delete Scriptures in your EasyWorship
Schedule, as well as the powerful search functions in EasyWorship, which make it simple to
find, customize, and present Scriptures to your audience.

Adding Scripture to the Schedule

Adding a Single Verse

1.
2.
3.

Click the Scriptures tab in the Resource Area.

Select a version of the Bible from the Resource Library on the left.

To search the Scriptures by reference, click the icon in the Search field above the
bible list. When it looks like a line list (=, it's set to search by reference.

Type your reference in the search box above the Resource Area.

5. Drag-and-drop the selected scripture to the Schedule Area.

To search the Scriptures by keyword, click the icon in the Search field above the
Resource Area. When it looks like a magnifying glass (4, itis set to contextual

search (i.e., keyword).
Type in any word or phrase to find what you’re looking for.

Drag-and-drop or double-click the selected scripture to add it to the Schedule.

Adding Multiple Consecutive Verses

Songs | Scriptures | Media  Presentations  Themes

IEIEIEIE.Er

— lohn 1:1-19| I Translation Reference Seriptu
KAR ~ | KNV John 1:1 In thel

Ky KV John 1:2 The sa

LS5 KIV John 1:3 All thir
LUTH1545 KIV John 1:4 In him
MAGR] KIV John 1:5 And th

¥ nr lake 1.5 Tlhmrn

1.

You may want to add consecutive verses to the schedule at one time, such as John
1:1-15. Under the Scriptures Tab in the Resource Area, select the version of the

Bible you would like to use from the Resource Library on the left.
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2. To search the Scriptures by keyword, click the Search icon above the bible list.
When it looks like a line list (=, it's set to search by reference.

3. Type your scripture range in the Search field (e.g., John 1:1-15). The scriptures are
automatically highlighted below in the Resource List.

4. Drag-and-drop the selected block of verses to the Schedule Area.

5. You may also type a single scripture in the Search field (e.g., John 1:1). This search
will return and ordered list of verses. You can then click the first verse, hold down the
Shift key on the keyboard, click the last verse in the range of verses you want to
include, then drag-and-drop the selected block of verses to the Schedule Area.

6. By default, EasyWorship will reflow the text to a new slide when the maximum text
area isfilled.

Adding Multiple Non-Consecutive Verses

1. You may want to use multiple non-consecutive scriptures such as Genesis 1:1,5,7, 8
and 12. Under the Scriptures Tab in the Resource Area, select the version of the
Bible you would like to use from the Resource Library on the left.

2. Search for and click your desired scripture (e.g., Genesis 1:1), then hold down the
Ctrl key on the keyboard and click each verse you want to display.

3. Drag-and-drop the selected verses to the Schedule Area.

4. EasyWorship will separate each verse into its own slide.

Editing Scripture

Using the Schedule Editor

1. Add a scripture to the Schedule Area.

2. Right-click the scripture in the Schedule and select Edit Item.... The Schedule
Editor will appear.

NOTE Selecting a scripture in the schedule will display the scripture in the Resource Area.

1. Make any needed changes (editing scripture is the same process as editing a song in
the Schedule).
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To change the default scripture reflow setting so EasyWorship will create a new slide for

each verse:

1. Click Edit > Options....

2. Under Live > Scripture, check the option to Break on new verse.

3. Click OK.

Searching Scripture

Quick Search

o Forareference search such as 1 Thessalonians 1:3:

1. Inthe search box, type "1 The". EasyWorship will then auto-complete the book name

for you as 1 Thessalonians.

2. Pressthe Spacebar, then type in the chapter, 1.

Press the Spacebar, then type in the verse, 3.

Contextual Search

« For a contextual search, like the word "hope":

Songs i Scriptures. Media Presentations Themes

Iq hope I Translation Reference Scripture
B kar A KV Ruth 1:12 Turn again, my daughters, go [your way]; fo

—
iﬂi 156G KV Ezra 10:2 And Shechaniah the son of Jehiel, [one] of t
[ LuTH1545 of the land: yet now there is hope in Israel ¢
iﬂi MAORI KV Esther 9:1 Mow in the twelfth month, that [is], the mo
E v the day that the enemies of the Jews hoped
Mi MIVA KJV Job 46 [Is] not [this] thy fear, thy confidence, thy h
i!i MKV KV Job 5:16 So the poor hath hope, and iniquity stoppel
i!i RST KJV Job 611 What [is] my strength, that | should hope? &
i!i RVA KJV Job 6:20 They were confounded because they had h
iﬂi SFRO8 KV Job T:6 My days are swifter than a weaver's shuttle,
iﬂi Sy1917 KWV Job 813 So [are] the paths of all that forget God; anc
B T KV Job 8:14 Whose hope shall be cut off, and whose tru
B win v | KV Job 11:18 And thou shalt be secure, because there is

Fow | v &

1. To search the Scriptures by keyword, click the Search icon above the bible list. When
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it looks like a magnifying glass (4, it's set to contextual search (i.e., keyword).

2. Type inthe word hope.

3. Every verse in the bible with the word "hope" will be listed.

Using Scripture on the Fly

Single Verse

1. Click the Scriptures tab in the Resource Area.

2. Select the Bible version you want to use from the Resource Library on the left.
3. Type the scripture reference in the Search field above the Resource Area.
4

. Double-click the selected scripture to make it go live.

Multiple Verses

1. Click the Scriptures tab in the Resource Area.

2. Select the Bible version you want to use from the Resource Library on the left.
3. Type the scripture reference in the Search field above the Resource Area.
4

. Hold down the Shift key on the keyboard, then use your mouse to click consecutive
verses, OR hold down the Ctrl key on the keyboard and use your mouse to click mul-
tiple non-consecutive verses. Once the verses have been highlighted, click Play next
to the Search field to make your selection go live.
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Songs

In this article, you'll learn how to add, edit, and delete songs in EasyWorship, how to
customize song slides (backgrounds, custom labels, additional text fields), how to import
songs from Song Select Lyric Service or an existing EasyWorship database, and how to
locate and display a song to the audience.

Add a Song

The EasyWorship Song Editor allows you to add a new song to the songs Resource
Area database by typing it, by importing it, or by copy and paste.

1. Click the + icon button at the bottom of the song list, or right-click any song under the
Songs tab in the Resource Area, and select New Song.

2. The Song Editor appears.

B Song Editor - Untitled m] %
- 1@ | T @ =. B @
124 L Theme Tedt  Scripture  Media Armange | Inspector
Tahoma v| | Auto v amas [Ov|[m] 1 [us]o]| =[=]=]| =[=]=
Words  Slides
18

057, N =7

™ i 2 -

*’afﬁ' i i 3 copyright

& - Insert i | (=]
oK Cance

Edit a Song

The EasyWorship Song Editor allows you to edit songs, miscellaneous text, and song
information. When editing a song, you can choose either to save your edits to the song in
the current schedule only, or to save your edits to the song permanently in the song
Resource Area.
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For video tutorials on song editing, click the links below:

« Basic Song Editing

« Advanced Song Editing

|Exndu5 211 (KIV) | = . B .
o ‘;’/" Ll'l':l:;iFlne T£ Scﬁqure Media ng
|Tahnma V||Auto V| AT A |E|I g| = EEH EE'& |
. Enter a name for the song, scripture, theme, or present-
Title B
ation in this field.
Theme Use the drop-down to select a theme. (This option is
grayed out in the Theme Editor.)
Text Adds a text box to display on each slide.
. Click the scripture button to select scripture text and
Scripture . )
press enter or drag it to add it to the theme.
Click the media button to select videos, images, feeds,
Media DVD clips, or audio and press enter or drag it to add it to

the theme.

Clicking this button allows you to set the layer at which
Arrange the selected element resides. You have the option of
Move Up, Move Down, Bring to Front, Send to Back.

Opens the Inspector window. This allows you to make

PRt more detailed formatting changes to different elements.

Allows you to import a text document into your song,

Import presentation, or theme.

Allows you to print the song, schedule, theme, or present-

Print )
ation.

Checks spelling and allows you to make spelling changes
or add words to the dictionary. To add a language to the
spell check dictionary, click the Spell Check button and
select Spelling Options....

Spell Check | | W . 1
Q- K Theme Text !

Tahoma Check Spelling lv av oA [
Spelling Opticns... |

Words  gjide
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1. The Spelling Options window will
appear. Select the Language tab.

142

Spelling Options
Speling Landuagde  Custom Dictionany

Language zettings

Englizh e

Additional dictionaries

Choosze the language dictionary to uze when checking =p

Choose any additional dictionarnies to uge when checking

autocomect, adu cuztom dictionary

[] custom.dic kicrozaft Office custam

Locate Dictionaries. ..

Learn About bdak

Dol

[

2. Click Download Additional Dic-
tionaries. The Additional Dictionaries
page will load.

3. Download the dictionary you wish to
add to EasyWorship.

4. Browse to the file you downloaded
and extract it.

5. Inthe Spelling Options window,
click Locate Dictionaries....

6. Browse to the folder you extracted,
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selectit, and click OK. The new
dictionary will now be available in the
drop-down list under Language
settings.

Click the font selector to select the font formatting you
wish to use on selected text.

Allows you to choose between setting an exact font size
or automatically sizing the font.

Changes the font size of the text to the point size selec-
ted.

Allows you to change the color of selected text by select-
ing from the color palette provided.

Bold, Italics, Underline, Shadow, Outline

Left Align, Center Align, Right Align

Top Align, Middle Align, Bottom Align

Increase or decrease the indent level of the paragraph.

Resets formatting to default settings.

v Insert

Apply changes to items in schedule

Check this box to apply all of the edits made in the Editor
to that item in the currently-open schedule.

1. Type a name for the song in the Title box.

2. Type the label you want to use for the slide under the Words tab. (e.g., Verse 1,

Chorus, Intro).

3. Type the lyrics for the song in the Words tab.

4. To create a new slide, either press Ctrl+Enter after typing the slide text or click the
Add icon at the bottom left corner of the Words tab.

Edit a Song in the Schedule
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Inthe Schedule Area, select the song to be edited.
Right-click the song and select Edit Item....

The Schedule Editor window appears.

A oD~

The Words tab or Slides tab can be used to enter or edit text as needed. If you have
along verse and need to break into a new slide, you can press Ctri+Enter to do so.
This must be done in the Words tab. In the Slides tab, you can select multiple slides
to edit, duplicate, or delete.

5. Use the toolbar to change the font and size of the text, the style, and the alignment.

6. Use the header buttons to select a Theme, create a new Text box, add a Scripture,
add a Media element, or Arrange Elements (See Customize Song Slides).

7. Use the Inspector to customize your song any way you want.

Edit a Song in the Database

1. Inthe Resource Area, click the Songs tab.
2. Select the song you wish to edit.

3. Right-click the song and select Edit Song.
4

. The Words tab or Slides tab can be used to enter or edit text as needed. If you have
along verse and need to break into a new slide, you can press Ctri+Enter to do so.
This must be done in the Words tab.

5. Use the toolbar to change the font and size of the text, the style, and the alignment.

6. Use the header buttons to select a Theme, create a new Text box, add a Scripture or
Media element or Background, or Arrange Elements.

7. Use the Inspector to customize your song.

Edit Song Copyright Information

The CCLI# appears by default when a song is copyrighted, or you can add the copyright
symbol and date to the Inspector in the Song Editor. Once you have entered the CCLI #, it
will automatically appear in each copyrighted song. To add/edit the CCLI #, follow these
steps:

1. Click the Songs tab in the Resource Area.

2. Right-click the song and select Edit Song.

3. Click Inspector in the top-right corner of the Song Editor to display the Song Inform-
ation.

4. Editthe desired information and close the Inspector.
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5. Inthe Song Editor, click OK to save your changes.

Customize Song Slides

You can select a Theme, create a text box, add Scripture or Media, and use the Arrange
and Inspector buttons on the toolbar to format your new song.

Select a Theme

Click Theme on the toolbar and select the desired Theme you would like to use for that
song.
Add Another Text Box

Click Text to add another text box to the current slide.

Add a New Slide

Click the + icon in the bottom left corner to create a new slide, and then type the new slide
text.

Splitting Slides

If you need to split an existing slide into two or more slides, move the cursor to the
beginning of the line you wish to be the first line of the new slide and press Ctrl+Enter on
the keyboard.

Insert Labels

1. When a new slide is added, there are two field options. One for Label and one for
Song. Click where it shows label and type in your label. i.e., Verse1 or Chorus
2. Then press Enter to type the new song text.

3. Click OK when you are satisfied with the song.

Add Scripture to Current Slide

1. Click Scripture on the toolbar.

2. Select the translation you would like to use.
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3. Search for the scripture you would like to use.

4. Either double-click the verse(s) or drag and drop the verse(s) to add the scripture to
the current slide.

5. The scripture will be added in its own text box that you can resize and move if
needed.

Add Media
Add media as a background for the whole song

Click Inspector on the toolbar.
Click Background.
Select your Fill Style.

For each respective style, choose all the options you want to use.

o M 0N~

Click the Apply to Theme button at the bottom.
Adding media as a background for a single slide

1. Click the Slides tab in the upper-left of the Song Editor.
2. Click Media on the toolbar.

3. Select the type of media you want to use from the drop-down (Videos, Images,
Feeds, DVDs, Audio).

4. Drag-and-drop the desired media file to your desired slide under the Slides tab on
the left.

Adding media as an element to the current slide

1. Click the Slides tab in the upper-left of the Song Editor.
2. Click Media on the toolbar.

3. Select the type of media you want to use from the drop-down (Videos, Images,
Feeds, DVDs, Audio).

4. Double-click the desired media file (you can also drag-and-drop the media file to the
selected slide directly below the Media tab).

5. Resize and move the element to your desired location on the slide.

6. You can select the element and arrange it to the front or back by clicking Arrange on
the toolbar.

7. Click OK when you are satisfied with the song.
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Delete a Song_]

Remove a Song from the Schedule

1. Inthe Schedule Area, locate the song you would like to remove.

2. Right-click and select Remove From Schedule from the pop out menu.
3.
4

. Click Yes to remove this song from the schedule.

You will get a confirmation asking if you’re sure you want to delete this schedule item.

Delete a Song from the Database

WARNING! The following procedure permanently deletes the selected song from the
EasyWorship Songs database.

In the Resource Area, locate the song you would like to delete.

Right-click that song and select Delete.

3. You will get a confirmation asking if you’re sure you want to permanently delete this

song.
Click Yes to permanently delete the song from the songs database.

Import a Song or Text

Import a song from document

1.

Open EasyWorship, Click the + icon at the bottom of the song list to create a new
song.

Click the Import icon to the left of the printer icon at the top of the editor. The Win-
dows Open dialog box appears allowing you to locate the desired file.

Click OK when you have located the file. The song or text appears in the text box
where you can edit and format it.

NOTE ‘“Interlude" and "Vamp" are automatically recognized as song tags when importing
song text.

Import a song from SongSelect Lyric Service
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Refer to SongSelect for instructions on importing songs from SongSelect.

Copy / Paste

1. Type a name for the song in the Title box.

2. Type the label you want to use for the slide under the Words tab. (i.e., Verse 1,
Chorus, Intro).

3. Paste in the text you copied from another source (Word, Notepad, website).

NOTE If you have made changes to the attributes of the song and you want to change it back
to the default, click the Reset to Default button. If you delete or change the actual text, you
can use Ctrl-z to undo the changes.

Locate and Display a Song

1. Inthe Resource Area, click the Songs tab.
2. Type the name of the song in the search box for a Title search, or change to a Con-
textual search and search by keyword (e.g., popular phrase in the lyrics).

3. Ifyou are doing a Title Search, you can begin typing and EasyWorship will auto-com-
plete the text with the best match alphabetically.

4. After you locate the song, drag-and-drop it from the Resource Area to the Sched-
ule Area.

5. OR select the song in the database and click Go Live, or double-click the song to
send it directly to the Live Output Area.

6. Click each verse in the Live Area and follow your leader, OR use the UP and DOWN
arrows to advance to the next slide.
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Themes

Themes are design templates that can be applied to songs, scriptures, and presentations.
Once you've taken the time to design a Theme by customizing your text format, background,
and layout just the way you want, it can then be applied to any song, scripture, or
presentation in your Schedule Area in seconds. Just save your new Theme to your Theme
Library, then drag-and-drop it on top of a song, scripture, or presentation in your Schedule.
You can also select and apply it using the Theme button in any one of the Song, Scripture, or
Presentation Editors.

Creating A Theme

It's quick and easy to build a theme in EasyWorship using the Theme Editor. To get started,
click the Themes tab in the Resource Area, select the type of theme you want to create
(Song, Scripture, or Presentation), and then click the + (Add) button at the bottom of the
Themes Area. You may also create a theme by selecting one or more media items, right-
clicking on the selected media item(s), and selecting copy to Song, Scripture or
Presentation Theme. This will place the media item in the Themes Area, allowing you to
use it as the default theme (a.k.a., background) or drag-and-drop to a song in the schedule
or select it from the themes drop-down in the song or presentation editor.

Right-Click Features

When right-clicking a thumbnail in the Themes tab in the Resource Library, you have the
following options.
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Songs  Scriptures  Media  Presentations [ Themes )

& ¥ Search Any Field Title
THEMES
[7:] Song
iijj Scripture ~uta ) i :
L= | Presentation ::1::3 t::’&'ﬂ‘:::f?—;.g
COLLECTIONS song textinethree

MY COLLECTIONS

Mew Song Theme..,

Edit S5ong Theme...

Import Theme File...
Export Theme File...

Set As Default Song Theme
Delete
Wiew
Sort by
W song textlline Refresh

. New <Song, Scripture, Presentation> Theme...: This will open a new Theme Editor.

Edit <Song, Scripture, Presentation> Theme...: This will open the selected theme in
the Theme Editor.

Import Theme File...: Opens a file selection window to choose an existing theme to
import.

Export Theme File...: Allows you to export the theme for use on another computer.

5. Setas Default <Song, Scripture, Presentation> Theme: This sets the selected theme

© ® N 2

as the default theme for the Song, Scripture, or Presentation.
Delete: Deletes the theme from the Resource Library.

View: allows you to change icon size for a custom thumbnail view.
Sort by: the same as in Windows.

Refresh: This will refresh the thumbnail for the selected item.

Theme Editor

The Theme Editor is similar to the Song and Presentation Editors in that it has slides, an
Inspector, and it allows you to add media and text boxes to slides. However, unlike the Song
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and Presentation Editors, the Theme Editor does not allow you to add or change text on the
slides. The Theme Editor is designed for making overall formatting and placement changes,

not changes to the text or other content on the slides.

Toolbar
|Exodu:2:11 (KIV) | = . v -
o B & - LlT;1_érF7'|1e T£ S(ri@ure Media P\\-%Ige
|Tahnma V||Auto v| AT A |§|I QE” = EEH EE'; |
. Enter a name for the song, scripture, theme, or present-
Title L
ation in this field.
Theme Use the drop-down to select a theme. (This option is
grayed out in the Theme Editor.)
Text Adds a text box to display on each slide.
Scripture Click the scripture button to select scripture text and
P press enter or drag it to add it to the theme.
Click the media button to select videos, images, feeds,
Media DVD clips, or audio and press enter or drag it to add it to
the theme.
Clicking this button allows you to set the layer at which
Arrange the selected element resides. You have the option of
Move Up, Move Down, Bring to Front, Send to Back.
Insbector Opens the Inspector window. This allows you to make
P more detailed formatting changes to different elements.
Allows you to import a text document into your song,
Import .
presentation, or theme.
Print Allows you to print the song, schedule, theme, or present-
ation.
Checks spelling and allows you to make spelling changes
Spell Check or add words to the dictionary. To add a language to the

spell check dictionary, click the Spell Check button and
select Spelling Options....
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B R |
ik AB
Ly~ i Theme Text !
Tahoma Check Spelling > - as [

Spelling Options...

Words  5jide

1. The Spelling Options window will
appear. Select the Language tab.

Spelling Options
Speling Language  Custom Dictionary

Language zettings
Choosge the Janguage dictionary b uge when checking zp

Englizh e

Additional dictionaries

Choosze any additional dictionarnies to use when checking

autocomect adu cuztom dictionarny
[ ] custom.dic kicrozaft Office custam

Locate Dictionaries. ..

Learn About b4k
Dol

[

2. Click Download Additional Dic-
tionaries. The Additional Dictionaries
page will load.

3. Download the dictionary you wish to
add to EasyWorship.
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4. Browse to the file you downloaded
and extract it.

5. Inthe Spelling Options window,
click Locate Dictionaries....

6. Browse to the folder you extracted,
select it, and click OK. The new
dictionary will now be available in the
drop-down list under Language
settings.

Click the font selector to select the font formatting you

Font Selector wish to use on selected text.

Allows you to choose between setting an exact font size

SOOI or automatically sizing the font.
. Changes the font size of the text to the point size selec-
Font Size
ted.
Allows you to change the color of selected text by select-
Font Color . .
ing from the color palette provided.
Text Style Options Bold, Italics, Underline, Shadow, Outline

Horizontal Alignment

Options Left Align, Center Align, Right Align

e et Top Align, Middle Align, Bottom Align

Options
Indent / Outdent Increase or decrease the indent level of the paragraph.
Reset Styles Resets formatting to default settings.

v Insert

Apply changes to items in schedule

Apply changes to items in

szl Check this box to apply all of the edits made in the Editor

to that item in the currently-open schedule.
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Presentation Themes

When you add a Presentation Theme, you'll notice that it has more default slides than a
Song or Scripture Theme. That's because a Presentation Theme has many different types

of content slides that can be added to it (e.g., Title Slide, Title and Content Slide, Content
Only Slide, Blank Slide, and Scripture Slide).

Theme Button

When editing a song, scripture, or presentation, in the Editor's main toolbar you'll see a
Theme drop-down button. Click this button and select an existing theme to apply its layout
and formatting to the song, scripture, or presentation you're working on. You may also drag-
and-drop a theme onto a song, scripture or presentation in the schedule from the Themes

Area.

B Schedule Editor - Genesis 1:1 [ASV)

Genesis 1:1 (A5V)

===
= . 1
@] T @ = 5 O
Theme Text Scripture  Media Arrange Inspector

|Tah0ma

;| 41

| Words | Slides '_

14 Genesis 1:1 (ASV)

1 In the beginning God created the heavens and

the earth.

s L@ v« O = =63 f

1In the beginning God created

the heavens and the earth.
Genesis 1:1 (ASV)

30% {J

=

I QK || Cancel |
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Videos

EasyWorship allows you to use videos as an individual schedule item, as a background, or
as an element in a presentation. The following steps will show you how to add videos to the
EasyWorship Media Area and how to use them.

Adding Videos

EasyWorship can import videos that you have produced, or additional videos you have
purchased.

Resource Area

1. Click the Media tab.
2. Click the Videos tab.

3. Click Add at the bottom of the video resource list to access the Add Videos dialog
box.

4. Locate and highlight the video or videos that you want to import.
5. Click Open.

NOTE You can drag-and-drop a video from Windows File Explorer or the desktop into the
videos Resource Area.

Right-Click Options

When right-clicking a thumbnail in the Videos Resource Library, you have the following
options.
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Presentations  Themes

= Videos

[ Images

EH Feeds

(=) pvD

[#1] Audio
COLLECTIONS
MY COLLECTIONS

Title

95 A Psalm Of Praise

a

Christrnas Invite

Import Mew Videco File...
Edit Video Properties...

Copy to Theme

Set As Loge Background
Delete
View
Sort by
Refresh

1. Import New Video File...: this is a shortcut for adding additional videos.

2. Edit Video Propetties...: opens the Video Properties Editor.

156

3. Copyto Theme >: Select Song Theme, Scripture Theme, or Presentation Theme to
add the video to the desired theme library.

4. Setas Logo Background: sets the video as the default background logo. Clicking the

Logo button in the Toolbar will output the logo you selected to the screen. Clicking it

again turns off the logo.

5. Delete: deletes the video from the Resource Area. It will prompt you to delete it com-
pletely from the / Resources / Videos folder.

6. View: allows you to change icon size for a custom thumbnail view.

7. Sort by: the same as in Windows.

8. Refresh: This will refresh the thumbnails for the selected item.

Adding Videos from the Media Store

For information on downloading and installing free / sample media from the media store, see

Downloading Free Media.
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1. To purchase videos from the media store, log into your account and search for a video.

2. Once adesired video is located, click Buy Now. The Checkout / Payment Inform-
ation window appears.

3. Enter the appropriate payment information and click Place Order.

Playing Videos

In the Resource Area, click the Media tab.
Select Videos from the Resource Library on the left.
Drag and drop a video to the Schedule Area.

Select that video in the schedule and click the Go Live button.

o~ 0w N =

You may also select a video in the Resource Area and click Go Live.

Deleting Videos

Resource Area

Click the Media tab.
Right click the video that you want to delete.
Click Delete.

A message appears asking if you want to permanently delete the video.

o M 0w N =

Click Yes to delete the video.

Drag-and-Drop Features

1. Add to Schedule: Drag and drop a video into the schedule from the Images tab.

2. Use as Background: Drag a video onto a song in the Schedule to assign that image to
a song as a background.

3. Adda New Video: Drag and Drop a video from any folder in Windows to the videos
tab.
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Using Videos in Presentations and Songs

When creating or editing a presentation or song, you can access videos from the media
drop-down. You can drag and drop videos on to slides as an element or drag it to a slide in
the Schedule Area to make it a background for that slide.

Inspector

1.

Click Background under Slide.

2. Change the Fill Style to Media Fill.

Click the drop-down next to Select Media to select the video you wish to use as the
background.

Click Apply to Theme to set the background for all slides.

Video Properties Editor

Follow these steps to edit the properties of any video in EasyWorship:

1. Click the Media tab in the Resource Area.

2. Select Videos from the Resource Library on the left.
3.
4

. The Video Properties editor will appear, allowing you to customize properties of the

Right-click any video and select the option to Edit Video Properties.

video such as volume, aspect ratio, Mark In and Mark Out points, etc.
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Properties Tab

B Video Properties O X

Video Properties
MM Edit properties for What God Says About Money

PROPERTIES INFO

6 Title  |What God Says About Money |

o Clip Properties

s
s
Ar| 4w

eMedia Properties

Media Usage  QEINGN e &
Repeating | AUTO | = -
Aspect Ratio RGN o E=] (2]
0y 0:00 OAudio Properties
| 2 - o) ,2. 00 |5 Mute
Cancel

. Play / Pause: The Play / Pause button starts and stops the video playback.

. Fast-Forward / Rewind: Single clicking skips forward or backward one chapter. Hold-
ing the FFW or RWD buttons down will fast forward or rewind the video.

. Continuous Play / Repeat: button allows you to loop the dvd clip you are viewing or
let it stop at the end of the clip.

. Mute & Volume: button and volume slider only controls the audio while working with
the DVD clip. The audio will not be muted on playback.

5. Title : Type the name of the DVD clip in this field.

. Thumbnail: Click the thumbnail box on the right to set the thumbnail. (This takes a
snapshot of what is currently in the player window.)

. Clip Properties: Start Position is the time at which the DVD clip will start. Use the up
and down arrows to manually adjust the time. Mark In sets the start position of the
DVD clip. Click this button as the DVD clips plays to set the start position. End Position
is the time at which the DVD clip will end. Use the up and down arrows to manually
adjust the time. Mark Out sets the end position. Click this button as the DVD clips plays
to set the end position. Reset simply resets the Start and End Points.

. Media Usage changes how the background image behaves.
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Selecting the Picture icon i | stretches the image to fill the screen and loops.

Selecting the Movie icon ggg does not stretch the video or image and does not loop if

the background is a video.

The Repeating selector determines how a video will behave.
Aspect Ratio: Allows you to maintain the aspect ratio, stretch or zoom the video.

Audio Properties: Allows you to change the volume of the DVD clip when you go live
with it. The volume slider allows you to set the volume of the DVD clip for playback to
the audience. Mute allows you to mute the audio on the DVD clip if you don’t wish to
use the audio portion of the DVD.

Info Tab

# Video Properties =

L~ Edit properties for pgm_green radiance 1080.50480

Video Properties

PROPERTIES INFO

Title Opgm_green radiance 1080.50480
Author e
Copri © 0.

6 Description ‘I@ Tags 'J

(&) v 0:02 /015

ot | = o) CE——

oK l | Cancel

A o bd -

Title: Enter the name of the video clip in this field.
Author: Enter the Author in this field.
Copyright: Enter copyright info in this field.

© Button: Pressing the copyright logo button adds the copyright logo to the copyright
field.

5. Description: This drop down allows you to enter a description for the video clip.

Tags: This drop-down allows you to enter tags for the clip.
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Web Functions
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Media Store

Downloading Free Media

EasyWorship comes with a set of free media that you can download within the software. The
following instructions will walk you through downloading your free media.

1. Click Web @on the toolbar.

Web

2. Click Media at the top-left of the Web pane.

B EasyWorship - Your Church - Default — [m] x
File Edit Live Profiles Wiew Help

’o (H. bl & E. B 2 & | .4

New  Open Save Web Go Live Alerts Logo Black Clear Live

3]

Schedule 2 g “

Media~ SongSelect Web Support My Account  Login

Welcome Center easYWEeRSHIP

Your dashboard for Training, Support and Media

Training Support Media Store
Getting Started m Browse Our FAQs ¢ Download Free Me..
- L=

View all Training Videos Watch Support Videos Mini Movies
Sign up for Instructor-led Search our Help Topics Motion Backgrounds
Training Visit our Community Forums Countdowns
| Songs | Scriptures  Media  Presentations  Themes + >
= AHeart Like Thine Title Author
SONGS A Heart Like Thine Judson Van DeVenter (]
[7:] All Songs A Mighty Fortress |s Our God Hans Leo Hassler Martin Luther
COLLECTIONS A New Name In Glory C. Austin Miles
MY COLLECTIONS A Robe Of White Haldor Lillenas
Abide With Me Henry F. Lyte William H. Monk
Alas And Did My Savior Bleed Hugh Wilson Isaac Watts
Al eoteiece AF Mluee Cad And Viao 4 Cemmcic of Accicl Wl e Hene: Peanae h
< > Slide 1 of 5 >
| B | B 10of 223 songs -

3. Click My Account at the top- right of the media store page.
4. Click DOWNLOAD FREE MEDIA.

Media Downloads Licenses Credit Cards Order History Contact Info Favorites Organizations

MY DOWNO A HASED MED|A Enter text to search media All Media ~ B

‘ &5 DOWNLOAD FREE MEDIA

All Media| v

5. Hover your mouse over each media item and a download button will be provided.
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MY DOWNLOADS / FREE MEDIA

AllMedia [ V] s PURCHASED MEDIA

Christmas: So He C...

by Beamer Films

(MiniMovies)

Encourage others with this video about epic
story of Jesus... how his humility is our gift, his
pove... more

Quality MP4

SD 480p DOWNLOAD

6. Select the desired media format. EasyWorship 6 supports both mp4 or wmv file
formats. When provided the option for HD content, you may need to select SD if your
computer seems to lag when play HD video files through EasyWorship.

7. The downloaded items will appear in the Media tab of the Resource Area in their
respective folders (videos or images). The image or video thumbnail will appear faded
until the download has completed.

Purchasing media from the media store

1. Click Web é,, on the toolbar.

Web

2. Click Media Storeon the Welcome Center home page.

3. Enter a search term or select the desired media item.
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4= = M Mediav SongSelect Web Support My Account  Login

/ WELCOME BLUE TYPOGRAPHY

Welcome Blue Typography
by

$3.00

SD 480p

WELCOME ™

@ 0:00:00 m @ ®

4. Use the drop-down to select the quality of the media. Then, click Buy Now.

5. Complete the checkout process to finalize the purchase.
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If you have a subscription to SongSelect from CCLI, you can import song lyrics from

SongSelect directly into EasyWorship.

NOTE CCLlis aseparate company and not affiliated with EasyWorship.

1. Toimport song lyrics into EasyWorship, click Web > SongSelect.

[ EasyWorship - Your Church - Default
File Edit Live Profiles View Help

@T:I'Hli‘fjno

New  Open Save

Schedule

(ea) = | S | i M Media~  SongSelect Web

2. Sign into your SongSelect account.

& Welcome to SongSelect. See what's new_

% SongSelect

You can browse the tops songs or use the search function to find a specific song.

4. Once you find the song you want to import, select that song to go to the song's main
page. Then click Lyrics to go to the lyrics page for that song.

4 Welcome to SongSelect. See what's new.

% SongSelect Q search

@ Home < Overview
@ Favorites

Text Alignment
& Activity

Left
BROWSE
Font Size
Themes

Popular Songs
CCLI Top 100

Public Domain Songs

What's New

® s

Good Good Father

Verse 1

I've heard a thousand stories

Of what they think You're like
But I've heard the tender whisper
Of love in the dead of night

You tell me that You're pleased
And that I'm never alone

Chorus

You're a Good Good Father
It's who You are

It's who You are

It's who You are

And I'm loved by You

b Choras dLeag 4 vocal

Got Feedback? [

5. OR,ifbrowsing in a list, you can click the Lyrics icon to go to the lyrics page for that

song.
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. 2 3 4 5 > » 10 20 50 100

o Good Good Father Anthany Brown, Pat Barrett ® b |J |4

o Great Are You Lord David Leonard, Jason Ingram, Leslie Jordan w b |J |4
F N . . .

6. Click Importin the top-right corner of the window.

I
&
*

=D Q. = 2 LA

Go Live Alerts Logo Black Clear Live

7. The song will now appear in the Songs tab of the Resource Area.
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YouTube

As long as you have an internet connection, you can add a YouTube video to your schedule.

1. Open EasyWorship.
2. Click Web ré'.on the toolbar.

Web

3. Click Web in the browser window that appears.

# EasyWorship - Your Church - Default
File Edit Live Profiles View Help

e+

New Open

Schedule == Media~ SongSelect Web https://www.google.com/?gws_rd=ssl

In the address bar, type www.youtube.com.

Search for the desired video.

Once the video is playing, click Schedule in the upper-right of the browser window.

N o o &

A window will appear asking if you want to display the video full screen once you go
live.

Confirm X

o Would you like to display this video full screen?

1w

8. Click Yes. The video now appears in the schedule. Remember that this is only a link.
You must maintain an internet connection for the video to play.
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B EasyWorship - Your Church - Default - m] X |
File Edit Live Profiles View Help
o 0. B & - W . [« Ll
New Open Save Web Go Live Alerts Logo Black Clear Live

Slide 1 of 1

Public Domain ~

NOTE

If the video doesn't automatically start once you go live, move your mouse to the

secondary screen and click to start the video. Also, you cannot play videos that are copyright
protected by YouTube. If you add a copyright protected video to your schedule, once you go

live, you'll get a message saying the video will not play.
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Web Pages

As long as you have an internet connection, you can add a web page to your schedule.

1. Click Web té’,on the toolbar.

Web

2. Click Web in the browser window that appears.

¥ EasyWorship - Your Church - Default
File Edit Live Profiles View Help

New

Schedule = L B TG IER GEGRGRT T U EV  hittps://www.google.com/Tgws_rd=ssl

3. Inthe address bar, enter the desired URL.
4. Click Schedule in the upper-right of the browser window.

5. The web page now appears in the schedule. Remember that this is only a link. You
must maintain an internet connection for the web page to display.
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Backup And Transfer Your Database

The following instructions will help you transfer the EasyWorship database from one
computer to another. Before starting this process, you will need a USB flash drive or external
hard drive. In the steps below, we will call this your backup drive.

Transfer EasyWorship 6 database to another computer running
EasyWorship 6

Backup Your Database (Old Computer)

Connect your backup drive to the computer.
Close all other programs before starting.
Open EasyWorship 6.

Click Profiles > Profiles Manager....

Select the desired profile. Click the link next to Instance Location.

o g M w N =

Close the Profile Editor and EasyWorship (behind the File Explorer window that
appears).

7. Inthe File Explorer window that appeared during step 5, select all folders (Ctri+A).
8. Right-click any of the selected folders, select Send to >, and select the backup drive.

9. When the files are all transferred, disconnect the drive from the computer.

Restore Your Database (New Computer)

1. Connect your backup drive to the computer.
2. Close all other programs before starting.

3. Open the Windows File Explorer, or click Computer and browse to your backup
drive.

4. Select the folders you backed up from your old computer (should be called
Resources and v6.1) and press Ctrl+c OR right-click and click Copy.

Open EasyWorship 6.
Click Profiles > Profiles Manager....
Select the profile to which you wish to restore the database.

Click the link next to Instance Location

© ® N o o

Close the Profile Editor and EasyWorship (behind the File Explorer window that
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appears).

Rename all of the folders in the File Explorer window that appeared in step 8 by
adding 'old' after the folder name. (Resourcesold, v6.10ld)

Click in a blank area in that same window and press Ctrl+V on your keyboard OR
right-click in a blank area and click Paste.

Open EasyWorship 6 to verify your database has transferred successfully.

Transfer database from EasyWorship 2007/2009 to EasyWorship 6
Computer

On the EasyWorship 2007 or 2009 computer (Old Computer)

1. Connect your backup drive to the computer.

2. Open EasyWorship 2007/2009 on the old computer.

3.

4. Highlight the profile you wish to back up and click Edit the selected application

Click Profiles > Profiles Manager....

profile.

Click the field below Use an existing application data instance and use the right
arrow key to move the cursor to the end of the field.

Write down the path shown there, including the name of the folder at the end of that
path. (The typical location is C:\Users\Public\Public Docu-
ments\Softouch\EasyWorship\Default.)

7. Close the Profile Manager and EasyWorship.

Open Windows Explorer or Computer.

9. Browse to the folder in the path written down in Step 5. The typical location is C:\User-

10.

11.

12.

s\Public\Public Documents\Softouch\EasyWorship\Default.

Select all (Ctrl+A) folders in that folder. (Should be Databases, Options, and
Resources)

Right-click any of the selected folders. Choose Send to from the pop-out menu and
select the backup drive.

Take the flash drive to the EasyWorship 6 computer.

On the EasyWorship 6 Computer (New Computer)
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1. Connect your backup drive to the computer. (This will be the same backup drive you
used on the 'old computer' from the steps above.)

2. Close all other programs before starting.
3. Open the Windows Explorer, or click Computer and browse to your backup drive.

4. Highlight all folders backed up from 'old computer' (should be
Databases,Options,and Resources) then press Ctrl+C on your keyboard OR right
click any one and select Copy.

5. In Windows Explorer, browse to C:\Users\Public\Public
Documents\Softouch\EasyWorship\Default.

6. Rename all folders in that window by adding 'old' after the folder name
(Resourcesold, v6.10ld, Databasesold).

7. Clickin a blank area in that same window and press Ctrl+V on your keyboard OR
right-click in a blank area and click Paste.

8. When the folders are all transferred, open EasyWorship 6 and click the box to
Convert Data.

If you do not have a profile with the same name as the folder you trans-
ferred,

Open EasyWorship 6.

Click Profiles > Profiles Manager....

Click the + button to add a new profile.

Enter the name of the folder you transferred into the profile name file.

Select the Advanced tab and change the type to Existing. Click OK.

o o M 0w N =

You will be prompted to convert the database.
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Setting Up A New Computer

. On the new computer go to www.easyworship.com/support.

1

2. Download and install EasyWorship 6.
3.
4

Register EasyWorship 6. See Video: How to Register EasyWorship 6

. Transfer the database from the old computer using the Transfer Your Database

instructions.

5. Install Quicktime Player from the help menu in EasyWorship 6.

6. Install DScaler video decoder for Playing DVDs from the Video Decoders article.

7. Setup your monitors using the instructions in the Dual Monitor Setup article.
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Video Decoders

In this article:

1. Whatls a Video Decoder?
2. Install Quicktime for MP4 and MOV files
3. Install DScaler for DVD Playback

What Is a video decoder?

When you play a video or sound file through EasyWorship, it has to know how to decode that
file. A codec or decoder is a piece of software that tells EasyWorship how to decode the
video or audio file. If you don't have the proper codec installed on your computer,
EasyWorship won't be able to play your multimedia file. EasyWorship requires Quicktime
player in order to play MP4, M4A, M4V, and MOV files. Use the instructions below to install
Quicktime. EasyWorship also requires the DScaler decoder to play DVDs. Instructions for
downloading and installing the DScaler decoder are also provided below.

Install Quicktime for MP4 and mov files

1. InEasyWorship, click Help > Install Quicktime Support.

2. Click Download on the Install Quicktime box that appears.

3. Yourweb browser will open and direct you to the Quicktime download page.
4

. You do not have to enter any information on this page, just click the blue Download
Now button.

5. After downloading the Quicktime installer, open it and install it using the default options
provided in the install wizard.

6. Close and reopen EasyWorship. EasyWorship is now able to play MP4, M4V, M4A,
and MOV files.

Install DScaler for DVD Playback

1. Close EasyWorship.

2. Click here to access the DScaler download page at sourceforge.net.
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3. The download should start automatically. If not, click the direct link option provided.
Don't click any other links or buttons on this page.

4. Runthe downloaded file to install DScaler. Use the default settings to complete the
installation.

5. Open EasyWorship and click Edit > Options....

6. Click Advanced. Ensure that you have checked the box next to Use preferred
DVD video codecs and click OK.

NOTE EasyWorship will support WMV and WMA files without the use of additional video
decoders.
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Alpha Channel Setup

Before Getting Started

Alpha Channel support requires a single NVIDIA GeForce GTX series graphics card that
can support at least three simultaneous video outputs. Before using the alpha channel
function in EasyWorship, make sure your computer meets the system requirements for
alpha channel support. Connect the alpha channel and EasyWorship Output to the video
mixer and extend the Windows desktop to each output (see Enable Windows Extended
Desktop below).

The following instructions show you how to set up EasyWorship. They will not help you
configure your video mixer. Please consult the support resources for your mixer for help
configuring an alpha key on the video mixer.

Enable Alpha Key in EasyWorship

1. In EasyWorship, select Edit > Options.... The Options window will appear.

2. Inthe Live tab, change the Output Monitor option to the output you wish to use.
3. Change the Alpha Channel to the output you wish to use for the alpha channel.
4. Select OK.

NOTE If all of the video outputs do not appear in the drop-down boxes make sure the desktop
is extended to all displays. See Enable Windows Extended Desktop below.

Enable Windows Extended Desktop

1. In EasyWorship, select Edit > Options.... The Options window will appear.
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Foldback
Song

Scripture
Alerts and Clocks
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[ Options O >
P
Live Live Options
Song Select Qutput Monitor
Scripture Output Position

-
Top
Width
Height

' Monitor Setup
Transitions
Screen Margins
Service Intervals
Left Top
Advanced Right Bottom
Default Font
Default Font Default Font -
comng text line one
sorg et line two
song text line three
soneg text line fouwr
[] Preview Output Ok Cancel

2. Selectthe Live tab on the upper left.
3. Inthe section titled Live Options, select the Monitor Setup button.

4. EasyWorship will open the Screen Resolution dialog box.
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[ Screen Resolution — | *
A [ <« Display »* Screen Resolution v 0 Search Control Panel 0
Change the appearance of your displays
Detect
Identify
Display: 2. G246HL w
Resolution: 1920 = 1080 (Recommended]  ~
Orientation: Landscape ~
Multiple displays: | Extend these displays
This is currently your main display.
[] Allow the screen to auto-rotate Advanced settings
Project to a second screen (or press the Windows logo key S + P
Make text and other items larger or smaller
What display settings should | choose?
oK Cancel Apply

Select a monitor that is not enabled.

6. Nextto Multiple displays, select Extend these displays (repeat for all inactive dis-
plays).

7. Select Apply. The desktop will extend for 15 seconds and a prompt will ask you if you
want to keep the settings. Select Yes if you wish to keep the settings. The settings will
revert back if you don’t select yes.

8. Select OK.

NOTE If there is only one monitor in the Screen Resolution window or you are unable to
extend the desktop to monitor, your video card may not support multiple displays, or all video
outputs may not be connected to a display.
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NewTek Network Source Setup

EasyWorship can be configured to be a network source for the NewTek TriCaster video
mixers over your local area network. It only takes a few clicks to set up EasyWorship so that it
can be used a network source for the TriCaster.

1. Open EasyWorship.

2. Click Edit > Options.... The Options window appears.
3.
4

. Select the Output Format you wish to send to the TriCaster unit from the drop-down

In the Live tab change the Output Monitor to NewTek AirSend.

box.

On the TriCaster you can now select the EasyWorship computer as a network input.
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Profiles

Understanding Profiles

Profiles consist of both User Settings and Application data. User Settings consist of settings
like font size, color and transition settings, as well as information about the EasyWorship
window size and location. Application Data consists of databases such as songs and
backgrounds, along with videos, images, feeds, and DVD clips. Settings like the output
monitor setting are global settings that will affect all users and are not part of Profile settings.

What is the benefit of using Profiles? With a little bit of up front effort, Profiles let you store
databases in different locations and then associate multiple unique user settings to that
application data. Stated more simply, if Bob runs EasyWorship for the adults and Jennifer
runs EasyWorship for the youth group, they can both have access to the same resources
(songs, backgrounds, videos, etc.), but have completely different user settings so
EasyWorship looks, acts, and displays the way that fits their unique audience. Or, Bob and
Jennifer can create completely separate databases for their resources.

NOTE The profile data can be stored on the local hard drive, on a server, or shared network
folder. EasyWorship will create a Default profile in the following location:
C:\Users\Public\Public Documents\Softouch\EasyWorship.

Possible Profile Configurations

1. Use the same set of application data as another profile but different user settings.
(Example: Bob and Jennifer share the same resources [songs, backgrounds, videos],
but have different user settings so that Bob's slides are appropriate for the adults and
Jennifer's slides are appropriate for the youth.)

2. Use adifferent set of application data with the same user settings as another profile.
(Example: Bob and Jennifer have separate databases, so they don't mix resources
[songs, backgrounds, videos] but they have identical user settings.)

3. Use adifferent set of application data and a different set of user settings. (Example:
Bob and Jennifer have separate databases, so they don't mix resources [songs, back-
grounds, videos] and they also have different user settings.)

NOTE EasyWorship also allows for easy hot swapping between Profiles. This means that
EasyWorship doesn't have to be closed when switching from one Profile to another.
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Profiles Menu

The Profiles menu has multiple options. At the top are the names of all available Profiles that
have been created. "Default” is listed as the only available Profile until additional Profiles
have been created. To change Profiles, select the desired profile.

1. Profiles Manager allows you to edit and create profiles in EasyWorship.

2. Database Tools has a Rebuild/Fix Database option. This checks the database for
errors and fixes them.

Create a New Profile

EasyWorship will create a default profile automatically when it is installed. If another set of
data or settings is desired, creating a new profile can accommodate this need.

1. Click Profiles > Profiles Manager.

2. The Profile Editor screen appears.

Profile Editor >
Profile Editor
|_|J Manage existing or create new EasyWorship user profiles
W Default ) ) ) )
A Profile points to an instance of your data and resources either on your

lecal drive or a shared network drive. Within this instance you can share
options with others or create your own.

Profile Mame: Default
Instance Location:  Default

Options Name: Default

Switch To Ediit...

#|=|

Close

3. Click New or the Add (+) button to open the Add Profile menu.

4. Enter a name for the new profile (e.g., Youth, Pastor, Children, Spanish, etc.). The
"Start using this profile when finished" option is checked by default. If you do not
want to use the profile immediately, un-check this option.
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Click the Advanced tab to specify if you want to create a new Profile or use an exist-
ing profile by clicking on the Type drop-down menu box. You can also set a location
other than the default path (such as a network drive or another location on the local
hard disk).

Click OK to create the new Profile.

Once you have created the new Profile, you can create another profile, edit an exist-
ing profile, or click Close.

NOTE The default path location for Windows Vista, 7, and 8 will be located in
C:\Users\Public\Public Documents\Softouch\EasyWorship.

Create a Shared Database

e N~

© N o O

Click Profiles > Profiles Manager.
The Profile Editor screen appears.
Click New or the Add (+) button to open the Add Profile menu.

Enter a name for the new profile (e.g., Youth, Pastor, Children, Spanish, etc.). The
"Start using this profile when finished" option is checked by default. If you do not
want to use the profile immediately, un-check this option.

Click the Advanced tab.
Change the Type to Existing.
Click the Browse button. This will open the Browse for Folder window.

Navigate to the shared profile folder. For network databases, browse to [Network
Computer Name (e.g., WorshipPC)|\ Users\Public\Public Docu-
ments\Softouch\EasyWorship\

9. Select the profile folder (e.g., Default ).

10.

11.

Under Options, type in the name you want to use for this profile's options, or select a
name from the drop-down list.

Click OK.

NOTE If youwant to return to the Profiles Manager after creating the new profile, uncheck the
option for "Start Using this profile when complete.”
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Change Profiles

EasyWorship allows you to change profiles easily, giving you the ability to use different
databases and settings without closing the application.

1. Click Profiles.

2. Select the desired Profile.

3. EasyWorship will load that profile. If you have a Schedule open, EasyWorship will ask
you to close it before loading the selected profile.

NOTE Determining which profile is currently loaded is also easy. The current profile is the one
with a black dot on it when you click the Profiles menu.

Edit a Profile

To change the settings or folder location of a profile:

1. Click Profiles > Profiles Manager.
2. Select the profile to be edited.

3. Click the Edit button.
4

. The Edit Profile window appears with 3 tabs - General, Advanced, and Sort
Order. At the bottom of the window, you can opt to use the newly-edited profile after
edits are complete.
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Edit Profile

General | Advanced | Sort Order

Profile Mame

This name refers to the instance of data and resources
you are peinting to from this computer,

[] Start using this profile when finished

0K

Cancel

From this tab, you can edit the name of the profile.

185
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Edit Profile

General | Advanced | Sort Order

Instance Location

This is the location of a folder that
contains this profiles data and resources.

Type |§Existing P
Where | Ch A Documents Softouch\Easyworshiph Default Browse
Options

Within each instance of data, you can have multiple option sets to customize
the look for each profile. For example, adult service and youth service,

Options | Default | w |

[] Start using this profile when finished QK

Cancel

From here, you can change the Type of profile from Existing to New, specify where the

profile is located, and change the Options that are associated with the profile.

186
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Sort Order Tab
Edit Profile >
| General | Advanced | Sort Order
Language Used for Database Sort Order
| English (United States) [en-U5] w
Uze Default
[] Start using this profile when finished 0K Cancel

You can change the language used for the database sort order, for proper sorting in all
languages.

Locate Your Profile Data

You may eventually need to transfer your database from one computer to another, or copy
videos or images into the Resources folder. To find the location of the data for your Profile,
use the following steps:

1. Click Profiles > Profiles Manager.
2. Select the desired profile.

3. Clickthelink next to Instance Location. This will open the Default folder where your
Resources folder is located.

NOTE The databases will be stored in a Databases folder in a folder called Data. Videos and
Images will be stored in the Resources folder. Options for the profile will be stored in the Options
folder.
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Songs: Printing & Reporting

EasyWorship allows you to track song usage and generate song reports. EasyWorship also
has the option to print a list of the songs in your Songs Library. Each time you add, print, or
project a song, EasyWorship tracks that action and stores it for you in a viewable and
printable file.

NOTE Tolearn more about reporting the usage of songs for copyright purposes, please
contact Christian Copyright License International (CCLI) at www.CCLI.com.

» EasyWorship - Your Church - Default
File Edit Live Profiles View Help

Mew »

Open Schedule Ctrl+0 @l
Web

Save Schedule Ctrl+5

Save Schedule As...
Close Schedule

Reports and Printing » Print Schedule Report (Summary]...
Reopen 5 Print Schedule Report (Details)...
Exiit Print S5ong Activity Report...

Print Song List Report...

Save Schedule Report (Surmmary])...
Save Schedule Report (Details)...

Save Song Activity Report...
Save Song List Report...

Printing a Schedule Report

Maybe you want your staff to be able to reference a hard copy of the service or event
schedule. No problem. EasyWorship lets you print a schedule report in either a summary or
detail view.

1. With the desired schedule open in EasyWorship, click File > Printing and Report-
ing... > Print Schedule Report (Summary)...or Print Schedule Report
(Details)....
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o A Schedule Summary includes a summary of all of the media included in your sched-
ule.

« A Detailed Schedule allows you to print each song or item in the schedule, page by
page, including all the words on each slide of that song, and song information, such as
Copyright, CCLI License Number, Author, etc.

2. When the report appears, use the tools at the top of the page for navigation, saving,
printing, etc.

Printing a Song Activity Report

1. Click File > Printing and Reporting... > Print Song Activity Report....

2. The Select Report Period window will appear. Enter the desired report period dates
and click OK. The report will contain all songs used in EasyWorship during the report
period.

3. To printareport of the songs ADDED within the report period, check the Only dis-
play songs added within the report period box.

4. When the report appears, use the tools at the top of the page for navigation, saving,
printing, etc.

Printing a Song List Report

1. Click File > Printing and Reporting... > Print Song List Report....

2. The Song List will appear showing the alphabetical listing of the songs in your Songs
Library.

3. When the report appears, use the tools at the top of the page for navigation, saving,
printing, etc.

Saving a Schedule, Song Activity, or Song List Report

To save a report, select the desired option from the File > Printing and Reporting... menu.

A Save window will appear, allowing you to select what file type you'd like and where you'd
like the file saved.
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P EasyWorship - Your Church - General
File Edit Live Profiles View Help
B save Schedule Summary Report x
“ v A » ThisPC » Desktop » Build » plugins v O Search plugins »
Organize = MNew folder = - e
ol Name Date modified Type Size
Bibles 12/21/2016 258 PM  File folder
Extensions 12/21/2016 259 PM File folder
Packages 12/21/2016 2259 PM  File folder
Transitions / File folder
Web 12/21/2016 2258 PM  File folder
v
File name: “
Save as type: | Comma Separated Values (*.csv) “
Comma Separated Values (*.csv) k
Text File (*.txt)
# Hide Folders I e | |
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Custom Position

If you're building EasyWorship schedules at home or using Display Foldback with the Matrox
DualHead2Go, then you need to understand how to take advantage of custom position for
the Output Monitor.

Building a Schedule at Home

If a schedule is built on a computer using a different output resolution than the presentation
computer, the songs will not display the same way on the presentation computer as the
source computer. Setting a custom resolution on the source computer will correct this
problem.

On the Presentation Computer
Determine the output screen size of the presentation computer.

1. Open Display Settings on the presentation computer.
2. Clickthe second monitor.

3. The resolution for that screen will be displayed there, e.g., 1024x768.

On the Home Computer

1. In EasyWorship, click Options.
2. Under Live, select Output Monitor and change it to Custom Position.

3. Change the Width and Height to match the presentation computer resolution (e.g.,
Width = 1024p x Height = 768p).

4. Click OK.

Using Display Foldback with a Matrox DualHead2Go

To find out how to set Custom Position for Display Foldback, see Display Foldback (Stage
Display).
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Using A Presenter Remote

If you have at least EasyWorship 6.1.5, you can use a presenter remote to control
EasyWorship. If you had a programmable remote setup to work with EasyWorship 2007 or
2009, it should work with EasyWorship 6.

The standard hotkeys for EasyWorship 6 are: PgDown = Go Live, Arrow Down = Next
Slide, Arrow Up = Previous Slide.

If you have a presenter remote that cannot be programmed to match EasyWorship hotkeys,
follow the instructions below.

Changing Hotkeys Using the Hotkey Installer

You can download hotkeys file that will work for most presenter remotes.

1. Close EasyWorship 6.

2. Click Here to download the hotkey installer.
3.
4

. Open EasyWorship and test your remote. Make sure you click in the Live Area with

Allow the file to run and replace any files it asks to replace.

your mouse when testing.

If you wish to reset the hotkeys file to the default settings, download and run the
Hotkeys Reset file.

Changing Hotkeys Manually

1.

Close EasyWorship 6.

2. Goto Start > Run or right-click the start button and click Run.

In the Run box that appears type in %programdata% and press Enter. This will open
up Windows Explorer and display all of your installed programs.

4. Click Softouch, then EasyWorship.v6.1, and then Settings.

5. Open HotKeys.ini in a simple text editor, such as Notepad. The following information

is displayed.

[HotKeys]
BlackScreenKeys=C-66
ClearScreenKeys=C-67
GoLiveNextKeys=34
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GolLivePrevKeys=33
JumpBridgeKeys=66
JumpChorusKeys=67
JumpEndingKeys=69
JumplntroKeys=73
JumpPreChorusKeys=82
JumpSlideKeys=83
JumpTagKeys=84
JumpVerseKeys=86
LogoScreenKeys=C-76
ScheduleNextKeys=39
SchedulePrevKeys=37
SlideFirstkeys=36
SlideLastKeys=35
SlideNextKeys=78, 40, 32
SlidePrevKeys=80, 38, 8

If your remote is moving you to the next item in the schedule, it uses Page Up and
Page Down to navigate slides. Make the following changes.

« Change GoLiveNextKeys to O (zero).

o Add 34 to SlideNextKeys (SlideNextKeys=78, 40, 32, 34).
» Change GoLivePrevious to 0 (zero).

« Add 33 to SlidePrevKeys (SlidePrevKeys=80, 38, 8, 33).

If you are using a remote that is selecting the next or previous item in the schedule
but not going live, you have a remote that uses left and right arrow keys to
navigate slides. Make the following changes.

« Change ScheduleNextKeys to 0 (zero)

« Add 39to SlideNextKeys (SlideNextKeys=78, 40, 32, 39)
« Change SchedulePrevKeys to 0 (zero)

« Add 37 to SlidePrevKeys (SlidePrevKeys=80, 38, 8, 37)

6. Save the file and close Notepad.

7. Open EasyWorship and go live with a song or presentation to test the remote settings.
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Glossary

A

Alpha Channel
Alpha channel is basically a mask. It determines how an object's pixel col-
ors are going to blend with pixel colors from another object when the two
are overlaid. In EasyWorship, when placing text (e.g., lyrics) or a trans-
parent PNG (e.g., church logo) on top of a motion background or live feed,
alpha channel is the best way to generate clean, professional edges
around the text--especially important for IMAG, live stream, or HD broad-
cast. EasyWorship's alpha channel support was designed for those who
have a video mixer that uses alpha key to overlay text and graphics on a
video source. Alpha channel keying provides the best quality for text and
graphic overlays.

C

Capture Card
EasyWorship can project images from your computer through external
devices (e.g., DVD, VHS, Camera[s], Mixer) using a capture card. Most
capture cards are PClI cards that are installed into PCI slots on the mother-
board of your computer. Each capture card has its own input connections.
Some are RCA (composite) jacks, some are S-video, and some are
FireWire IEEE1392. It is important that you determine the type of interface
cable desired before you order your capture card.

Codec
A codec or decoder is a piece of software that tells EasyWorship how to
decode the video or audio file.

D

Deck
A group of slides in song, scripture, or presentation.

Display Port
DisplayPort is a digital display interface used to connect a video source to
a display device such as a computer monitor, though it can also be used
to carry audio, USB, and other forms of data.
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DVI
Digital Video Interface. DVl is a video display interface used to connect a
computer to a display device, such as a computer monitor.

E

Element
A single object on a slide, e.g., text box, image, etc.

F

Foldback
Foldback (stage display) lets the stage see a custom display with the cur-
rent presentation or video, a preview of the next scheduled item, a clock,
and private alerts.

Front of House
The display that the audience sees.

G

Go Live
Allows you to send the current item in the preview screen to the live
screen. Most people use the Go Live button at the top of the preview area
or press the Page Down key.

H

HDMI
High-Definition Multimedia Interface. HDMI is a digital audio/video inter-
face used to connect a compatible computer monitor, video projector,
digital television.

L

Live Output

The final version of the schedule, being displayed to the audience.
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P

Primary / Secondary Monitor
Primary Monitor allows the live output to be displayed on the Primary Mon-
itor behind the EasyWorship control screen. Secondary Monitor allows the
live output to be displayed on a secondary monitor.

Profiles
Profiles provide the ability to switch between desired options in EasyWor-
ship. For example, you can have a profile for each user or a profile for
each type of presentation you create with EasyWorship.

R

Resource
An audio, image, video, or presentation media file.

S

Schedule
A group of items for display during a service.

Slide
One display item, e.g., song verse, presentation, or PowerPoint display
unit

T

Theme
Special settings for a slide deck.

Themes
Themes are templates that you can apply to scripture, songs, and present-
ations.

Vv

VGA

Video Graphics Array. An analog video display interface used to connect
a computer to a display device, such as a computer monitor or projector.
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Video Card
Also known as a graphics card, is computer hardware that processed
video information and transmits it to a video output device like a computer
monitor or projector via a video interface such as a VGA, DVI, HDMI, Dis-
play Port or other video interface.

Video Mixer / Switcher
A device used to switch between several different video sources.
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